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INTRODUCTION

�Have you ever played a video game but wished you could 
change some things about it—such as giving the charac-
ters different powers, changing the type of world you play 
in, or adding another level? Or have you ever started build-
ing a really tall Lego tower but ran out of bricks before you 
finished? If you have, then you will love playing Roblox! 
Roblox lets you design whatever kind of video game or 
digital world you want—you don’t have to only play games 
that big companies make.

In Roblox, you can log in and join your friends in any of 
thousands of different game worlds. Some games are just 
for fooling around, some are about trying to reach a goal, 
and others are all about building cities or worlds. 

The best thing about Roblox is that it gives you the pow-
er to make whatever game you can dream up. You could:

•	 �Craft your own island to hang out on, with a mansion 
full of your favorite things, and invite friends over for 
a virtual party 

•	 �Create a zombie apocalypse where you and your 
friends have to fight back deadly monsters 

•	 �Make a silly game about collecting gumdrops and 
lollipops in a land full of giant candy
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This book will show you exactly how to make amazing 
games you and your friends will love. You’ll find out:

•	 �What’s on the Roblox site: how to use the site it-
self and play games that other people have made. 

•	 �How to use Roblox Studio: this is the program you 
use to actually make your own games. 

•	 �Ways to make awesome worlds: terrain building 
and big environments.

•	 �Fun objects and characters you can add to your 
worlds: buildings, cars, weapons, enemies, and any-
thing else you’d want to fill your game world with!

•	 �How to use scripts: this is how you make your world 
come alive.

•	 �What makes a good quest or mission: a goal helps 
your game have a real story to it.

•	 �How to make your game fun for multiple players: 
ideas like keeping score, working with or against an-
other player, and racing against a clock.

•	 �Ways to make money in Roblox: if your parents say 
it’s okay, there are ways you can make money from 
your games!

I bet you already have a million ideas in your head for 
great games you could make. Let’s go make them!
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�Roblox Is Always Changing
�This book contains a lot of information about Roblox, but 
it’s not a definitive guide on absolutely every nook and 
cranny of the entire game. Like any good game maker, the 
folks who make Roblox are always adding new features 
and ways to play, so it’s impossible for a single book to cov-
er everything. However, this is a great starting point.

This book will also not include any “get rich quick” 
schemes for making lots of money (Robux) quickly or for how 
to become rich off of making and selling things in Roblox. No 
matter what you read or see on the Internet, the only way to 
make money in Roblox is through hard work, creativity, and 
dedication. That’s it.

�Roblox User: Defaultio

�THIS IS A ROBLOX GAME CALLED LUMBER TYCOON 2.
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�Do you play with Legos and build elaborate 
buildings, vehicles, or crazy cool other cre-
ations? Or maybe you prefer Lincoln Logs 

instead? If those types of creative building toys 
are fun to you, then you already understand the 
foundation of Roblox. Imagine something just 
like that, but in digital form. Because Roblox ex-
ists inside your computer, it is infinitely custom-
izable. What’s more, you can play Roblox games 
with people from all around the world. The entire 
platform is more like a destination than a game 
since players can join into thousands of games 
that other users have made as they play with, 
talk to, and share experiences with friends.

Roblox first launched in 2006. Since then the 
game has grown to over 30 million active monthly 
players who have logged over 300 million hours 
of gameplay with over 500,000 users actively 
creating content for players.
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�

Roblox User: City Horizons Fan Club

�AN IMAGE OF THE ROBLOX GAME NAMED CITY HORIZONS.

In this chapter, you’ll learn why people play 
Roblox, how it is sort of like Minecraft, how to 
get started by creating your own Roblox account 
and user profile, and what you’ll find on the Ro-
blox website after you log in. You’ll also learn 
about the many ways you can play Roblox, no 
matter the gaming device you use.
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�WHY DO PEOPLE PLAY ROBLOX?

�Roblox is a game about doing and being whatever you 
want. Anyone can play the latest Star Wars game if they 
want to feel like they’re a Jedi, and anyone can play the lat-
est Madden if they want to become an NFL star. But what 
if you want to build your own restaurant and serve other 
people while wearing a Spider-Man costume? You can’t do 
that type of stuff in store-bought games.

In Roblox the only limitation is how much you’re willing 
to learn. It would be impossible to know everything there 
is to know about Roblox simply from reading a book like 
this since there is so much going on in the game. But it’s a 
great start.

Another awesome thing about Roblox is just how much 
cool stuff there is to do. If you wanted, you could play and 
create stuff entirely for free without paying anything at all. 
You can build games using bricks that look like Legos. You 
can create huge worlds full of flowing water and massive 
mountains. People spend hours changing up their worlds 
and making games that they share only with friends. 

�IS ROBLOX LIKE MINECRAFT?
Based on that previous description, Roblox probably 

sounds a lot like another popular world-building game 
you’ve likely heard of or played before: Minecraft. 
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�Mojang AB

�A SCREENSHOT OF THE GAME MINECRAFT.

�While they seem very similar at first, the games them-
selves are actually quite different:

MINECRAFT VS. ROBLOX
MINECRAFT ROBLOX

Randomly generated game worlds Custom-built games from scratch

Focused on building and survival Games can be about whatever you want

All worlds look very similar Games rarely look the same

�
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HOW TO CREATE A ROBLOX ACCOUNT

�Now let’s create an account! When you visit the Roblox 
website (Roblox.com), you should see the homepage, 
which looks like this:

�Roblox Corporation

�THE ROBLOX HOMEPAGE.

�The account creation 
process is easy and painless. 
It’s a good idea to do it with 
a parent sitting with you so 
you do it together. You’ll 
need to enter the following 
information into the form to 
set up an account. 

�BIRTHDAY
Be honest and input your actual birthday. If you’re 

under the age of thirteen, be sure to ask your parents if 
you can sign up. (They might want to read the Q&A for 
Parents at the end of the book for more information.)

�USERNAME
This is how people in the game will identify you. This us-

ername will float over your head while you’re playing, appear 
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on your profile, be used when listing your character for high 
scores, and everything else. Think of something that you feel 
comfortable with other people seeing, but don’t use your real 
name or anything else that could identify who you are in real 
life. The site will tell you if someone else already has the user-
name you want, and if it’s taken you’ll have to choose a differ-
ent one. Talk to your parents before you make a final decision.

�PASSWORD
Your password needs to be at least eight characters 

long and it should include both letters and numbers. Don’t 
use your name or username because that’s too easy for 
someone to guess. Try to mix up letters and numbers and 
include capital letters or punctuation. Write it down or 
store it somewhere safe in case you forget it. Talk to your 
parents about what password might work well.

Where it says Confirm Password, just retype the same pass-
word. The website asks you to do this to make sure you know it.

�GENDER
Pick either the male icon or the female icon. This will 

affect which gender your avatar in the game takes and will 
help you feel more connected to your character.

�FINAL STEPS
1.	 Click the check box to indicate you agree to the 

Terms of Use and Privacy Policy (which you should 
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read over and ask a parent to look at before you 
agree). 

2.	 Click Sign Up! 

�ADDING AN EMAIL ADDRESS
One thing you might have noticed is that you didn’t 

need to input your email address when creating an ac-
count. If you’re over the age of thirteen, an email address 
isn’t required to get started, but if you don’t provide an 
email address later you’ll be limited to what you can do. 
For example, you can’t use the forums, get Robux, or spend 
Robux. (Robux is a form of virtual currency used in Roblox, 
and you use it to purchase things like upgrades and special 
items in games.)

�Roblox Corporation

�THE ACCOUNT SETTINGS ICON.

�Click the small Gear icon in the top right corner of the 
website once you’ve logged in and select Settings from 
the drop-down menu. On this page you can input an email 
address. After doing so the game will email you a link to 
click to fully complete your account setup process. 
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�CREATING THE REST OF YOUR PROFILE

�Back on the Settings section of your profile, under the Ac-
count Info tab, you will also see two other fields labeled 
Personal and Social Networks. In the Personal section you 
can write a bit about yourself (but do not include informa-
tion about where you live or your real name) and which 
country you live in. 

�Roblox Corporation

�THE ACCOUNT INFO SECTION.

�In the Social Networks section (which appears under 
this Account Info section), if it’s okay with your parents, you 
can add links to your Facebook, Twitter, Google+, YouTube, 
and Twitch accounts. There is also an option to adjust the 
settings so these links are visible to either no one, friends, 
users you follow, your followers, or everyone. Choose the 
option that is most comfortable for you and your parents.

�ADDITIONAL SECURITY SETTINGS
When you made your account, all you did was provide 

a single password but you might want to add a few other 



18  THE ULTIMATE ROBLOX BOOK: AN UNOFFICIAL GUIDE

layers of security just for added peace of mind. If you click 
the Security tab on your My Settings page, you’ll find a list 
of other measures to take. 

�Roblox Corporation

�ADDITIONAL SECURITY SETTINGS.

�At the top is an option for 2 Step Verification. This means 
that if anyone tries to log in to your account from a device 
that has never logged in to your account before in the past, 
then you’ll get an email with an access code inside. Unless 
that code is entered at the menu upon logging in, the new 
device won’t be able to access your account. 

This is valuable because it’s easy for you to input the 
code if you’re legitimately using a new device such as a 
new computer, new tablet, or something else, but it adds 
extra security against hackers.
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�Protecting Your Password
�If someone ever messages you asking for your password or 
a box pops up on the screen during a game asking for your 
password, do not enter it. This is likely a hacking attempt 
and should not be trusted even if it looks and seems offi-
cial. The Roblox developers will never ask you for your 
password like that while you’re playing a game.

You can also add an Account PIN, which is like another 
layer of security in addition to your password. The Account 
Restrictions option is something your parents might want 
to use to be sure what you see on the site makes sense for 
kids your age. Finally, the Secure Sign Out option makes 
sure that all devices logged in to the account are logged 
out, even if you’re not actively using them at that time.

�ADDITIONAL PRIVACY SETTINGS
Clicking the Privacy tab of the My Settings page allows 

you or your parents to adjust who is able to make contact 
with you in the game and who can send direct invitations. 
The first field is called Contact Settings and it is automati-
cally set to Default. Most of the Privacy Settings fields are 
defaulted to Friends Only, but they can also be turned 
off or opened up entirely as you and your parents choose 
what’s most appropriate. Simply click the various fields to 
adjust who can send you messages, who can chat with you 
in the app itself, and who can chat with you in games.
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�Roblox Corporation

�PRIVACY SETTINGS.

�The Other Settings field determines who can invite you 
to VIP Servers and who can join you in games.

�BILLING
When you create a Roblox account, you are automatical-

ly placed in the Free tier. If you want to upgrade, then from 
the My Settings page you should click Billing. On the Billing 
tab you can click the Join Builders Club button to be taken 
to the Builders Club membership page. If you simply log on 
Roblox to play free games once in a while, it probably isn’t 
worth it to join the Builders Club. But if you want to try and 
sell some of the items in your games, you may want to see if 
your parents will allow you to sign up for one of the upgrad-
ed tiers. See Chapter 2 for more about the Builders Club.
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�NOTIFICATIONS
Notifications is the final tab on the My Settings section 

of the Roblox website. The two types of notification set-
tings that you can adjust are: 

•	 �Notification Stream: adjusts which types of notifi-
cations pop up in your stream on the website. 

•	 �Desktop Push: adjusts which notifications pop up in 
the corner of your screen while you’re playing.

�NAVIGATING THE ROBLOX WEBSITE

�When you log on to Roblox via a computer, your home-
page will look a lot different than it does when you’re not 
logged in. Instead of a page with signup fields you’ll see 
a personalized dashboard full of relevant and useful links 
and information.

Immediately below your username and avatar icon is: 

•	 �A list of your most recently played games 
•	 �Your personal feed and recommendations
•	 �Recent blog posts

In the bottom right corner you may notice a chat win-
dow that’s ready for you to send messages to other users. 
Just click the top blue bar to bring it up or minimize it. Let’s 
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minimize the chat feature for now and focus on the sidebar 
on the top far left side of the screen. It’s important to know 
about this sidebar because you’ll use it to navigate around 
Roblox most of the time. To access this sidebar, simply click 
the icon in the top left corner of the screen (this icon is 
shaped like a square made of three bars). The first option 
at the top of this sidebar is Home, which is where you are 
already. Let’s take a closer look at the other options.

�PROFILE
Your Profile page is a good central hub of information 

about you, your avatar, and your playing habits.

�Roblox Corporation

�ROBLOX PROFILE PAGE.
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�This page displays how many Friends, Followers, and 
people you’re Following on Roblox. The About sections 
shows the Personal information you may have input on your 
My Settings page when you first signed up. Below that you 
can see what your Roblox avatar looks like in either 2D (like 
a piece of paper) or 3D (like a toy action figure). The 2D 
version is front-facing and doesn’t move at all, while the 3D 
version will spin in a circle so you can see your character 
from all sides. It’s a bit quirky because if the box says “2D” 
that means you can click it to make your avatar appear 2D, 
not that it is currently being shown as 2D. Think of it like a 
button or a switch that only shows what happens if you were 
to press it. On the right is a list of everything that your avatar 
is wearing. You can click on each item for more information.

Below that are: 

•	 �Collections. These are items that can be created 
during avatar customization (that’s covered in Chap-
ter 2).

•	 �Player Badges. These are awards you’ve earned 
from various games. If you’re new to Roblox, then 
this area may not yet be present.

•	 �Statistics. This area shows when you joined Roblox, 
how many times you’ve visited your place (which is 
like your own personal home world in Roblox), and 
how many times you’ve posted on the forum.
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�MESSAGES
The next tab on the left sidebar is for your Messages. 

On this page you can read messages that you’ve received 
in your Inbox, see messages you’ve sent to other players 
via the Sent tab, view official News announcements from 
the Roblox developers, and access Archive messages that 
aren’t in your Inbox anymore. It’s like text messages or 
Facebook messages, except these messages are restricted 
specifically to Roblox.

If you’re new, then you probably will have only a mes-
sage from Builderman, the avatar for one of the game’s 
developers. Read what he has to say. He’s very friendly!

�FRIENDS
The Friends tab is located below Messages. There’s not 

much to do here if you don’t have any friends, followers, 
or people that you’re following. But if you do, this is where 
you’ll find them listed. You can add friends from inside 
games, which we will cover in more detail in Chapter 2.

�AVATAR
After that is the Avatar tab. Your avatar in Roblox is your 

digital representation within the game. Every game you 
play and everyone you see will recognize you based on 
your avatar. Your username will also float above your ava-
tar’s head at all times. As a result, you should think of your 
avatar as a mini version of you inside Roblox. 
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�Roblox Corporation

�AVATAR EDITOR.

�The items you can dress your avatar in are listed on the 
Avatar Editor page. From the top of the navigation bar you 
can switch to viewing specific options: Recent, Clothing, 
Body, Animations, or the Outfits that you’ve put together. 
The Animations tab lets you pick different ways for your 
avatar to do things like walking, running, and climbing. All 
Roblox avatars automatically do these things the same way, 
but using animations lets you make your character stand 
out more. 

We’ll talk more about changing your avatar in Chapter 2.
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�INVENTORY
Next is your Inventory. Everything your account owns is 

held here. It’s sort of like a giant, endless, virtual backpack 
that’s full of all of your stuff. Instead of using a locker, your 
avatar just crams everything onto this webpage.

�Roblox Corporation

�MY INVENTORY.

�Each of the items in the list shown are pretty clear. Most 
of them can be purchased, redeemed, or claimed (for ex-
ample: if it’s free) from the full Catalog, which is covered in 
the next chapter. 

�TRADE
Then we’ve got the Trade tab. The Trade section of 

the site works kind of like a combination of Messages and 
Inventory. When you make a trade, you’re sending some 
Robux or items to another player in exchange for some 
of their Robux or items. For example, you could trade a 
special item you have for 1,000 Robux from someone else. 
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Trades are a popular way for users to swap items in Roblox.

�GROUPS
Below Trade is the Groups section. Here, you can find 

players who like building and playing the same types of 
games that you like. Groups are also a way for players to 
ally themselves with other players and designate other 
groups as rivals to encourage friendly competition.

�Roblox Corporation

�GROUPS.

�On the main page for Groups, you’ll notice a few de-
fault categories to pick from: 

•	 �Building-focused groups. 
•	 �Military-themed groups. 
•	 �Roleplaying groups. In these groups, all of the mem-

bers pretend to actually exist within a specified 
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world and act out as if they were actors in a play. 
This is a fun way for players to be creative while still 
playing a game.

•	 �Fan groups. These groups are usually focused on 
collecting members who have a shared passion 
for a specific topic, such as pretending to be in a 
Roblox-themed high school or enjoying television shows 
or franchises such as Sword Art Online and Pokémon.

�FORUM
Next is the Forum section. You will probably spend a 

lot of time here if you get really into Roblox. The forum 
is divided into three main sections, each of which with its 
own subsections:

�Roblox
This section of the forum is mostly focused on the game 

itself. You can: 

•	 �Post comments about the features of the game and 
about playing it

•	 �Ask for technical support and help
•	 �Offer suggestions and ideas for improvement
•	 �Check on exciting new events and upcoming 

contests
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�Club Houses
This is a more casual section of the forum. Instead of 

chatting with the developers of Roblox and posing official 
questions and topics, the Club Houses let users interact and 
talk with each other more freely. The subsections focus on: 

•	 �General chat
•	 �Random off-topic discussions
•	 �Clans and guilds where players organize into groups
•	 �Deciding the best ways to take advantage of items 

available in the Catalog through trading
•	 �Trying to make Robux cash quickly

�Game Creation and Development
This area of the forum is best suited to users who want 

to make their own games. Subsections focus on: 

•	 �Trying to get lots of people to play your game
•	 �Designing new games
•	 �How to do advanced scripting to make higher-level 

games

�BLOG
Then there’s the Blog section of the site. This link will 

take you out of your own personal portal and send you to 
the Roblox Corporation’s official company blog. On this 
page you’ll find a new article from the employees at the 
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company written every few days. Topics include the game, 
upcoming features, updates, and events. 

You don’t have to read the blog at all to actually play 
and enjoy Roblox, but checking it out once in a while will 
help make sure you’re updated on all of the latest Roblox 
news and features.

�SHOP
Next, you’ll see the Shop option as the last link along 

the far left sidebar. This link also takes you outside of your 
main dashboard, but this time it will take you entirely out-
side of the Roblox website altogether. 

�Amazon.com

�THE ROBLOX SHOP.
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�The Shop link will take you to a special section of 
Amazon.com, where you can find an assortment of Roblox- 
related toys and other merchandise. Most of the items for 
sale on Amazon on this section are real, physical items so they 
don’t have anything to do with actual games or your avatar at 
all. You’ll need an adult’s help to actually buy anything.

�UPGRADE NOW
Below the Shop link there are still two more icons you 

can click on. First is a large, blue Upgrade Now button 
that’s impossible to miss. 

If you click this button, it will take you to the Roblox Build-
ers Club page. For more details on how the Builders Club 
actually works, check out the details in the next chapter.

�EVENTS
The final item in the far left sidebar is known as Events. 

This portion changes all the time, based on whatever pro-
motional content, event, or contest the creators of Roblox 
are hosting at any given moment. For example, while writ-
ing this book, one of the events was called Heroes.

�Event icons take you to a webpage that lists different 
activities and games that relate to a given theme, like He-
roes. By participating in the event and playing the selected 
games, you can potentially win prizes such as special shirts 
and other accessories for your avatars. These are popular 
incentives for players because they not only show others 
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the events you’ve played in, but the prizes can be worn by 
your avatar in other games within Roblox as well.

�Roblox Corporation

�EVENTS ICON.

�WAYS TO PLAY ROBLOX

�Roblox has been around long enough that the developers 
have made it playable on a bunch of different devices. It 
started out originally only as a PC-based computer game, 
but it can now be played on: 

•	 �Mac computers
•	 �Mobile devices such as tablets
•	 �Video game consoles
•	 �Virtual reality (VR) headsets

Before you can play on any of these platforms, be sure 
you make an account at the official website: www.roblox.com. 
After that, visit the Roblox homepage and scroll all the way 
down to the bottom to click on the link for the specific 
device you’re interested in playing Roblox on if not on the 

Events
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main website portal. Those links take you to the download 
pages for your device. You should know that the majority 
of this book focuses on the computer version of the game. 
This is because only the computer version of the game cur-
rently lets you use Roblox Studio to build your own worlds.

Regardless of which platform you choose to play the 
game on, you will be playing online with everyone else at 
the same time. This means that even if one person is on an 
iPhone, someone else might be wearing a VR headset, and 
another person might be playing on their laptop. Regard-
less, they’re all sharing the same world at the same time.

�PLAYING ON A COMPUTER
Most people play Roblox through a Windows or Mac 

computer since that gives them the most features and 
flexibility. You can use either a gamepad or keyboard and 
mouse controls when you play. 

To get started with Roblox on a computer, just log in, 
search for a game, and click the Play button. If the Roblox 
Player isn’t installed on your computer, then you’ll need to 
download and install it. The Roblox site will prompt you 
through the process.
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�Roblox Corporation

�INSTRUCTIONS FOR INSTALLING THE ROBLOX PLAYER.

�The default way of playing Roblox is online through 
your Internet browser. But if you would rather play Roblox 
on your computer itself (not through a browser), then you 
or your parents can download a Windows 10–compatible 
version of the game from the Windows Store. 

Regardless of how you choose to access Roblox, each 
game you play will have slightly different controls. For 
more details on actually playing games in Roblox, check 
out Chapter 2.

�PLAYING ON A MOBILE DEVICE
You can also play Roblox for free on mobile devices. 

This includes iPads and iPhones (by downloading the Rob-
lox app on the Apple App Store) as well as Android devices 
(by downloading the Roblox app from Google Play or the 
app store on Amazon.com). While you can technically play 
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on smartphones or tablets, I’d recommend playing on a 
tablet since the bigger screen will make it much easier to 
play and navigate.

If you want to purchase Robux for premium content, 
then you can do that from the Roblox website. To begin 
the process, click or touch the R$ icon in the top right cor-
ner of the website. See Chapter 2 for more information 
about Robux. 

�PLAYING ON A GAME CONSOLE
In addition to computers and mobile devices, you can 

also play Roblox for free on the Xbox One game console. 
Just talk to your parents, then navigate to the Xbox Store 
using your Xbox One and search for Roblox. After you log 
in, you’ll be able to access thousands of games that users 
have made. 

Just like on mobile devices and PCs, you can also pur-
chase Robux for premium content for the Xbox One. See 
Chapter 2 for more information on Robux.

�PLAYING WITH A VIRTUAL REALITY HEADSET
If you have a compatible VR headset, such as the Ocu-

lus Rift, you can use it to play Roblox as well. All you have 
to do is make sure your Oculus Home settings allow you to 
play content from unknown sources before trying.

Then, when your headset is plugged into the computer, 
Roblox will automatically launch any game you play in VR 
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mode. Other than viewing the game through the headset 
and being able to look around with your head, you’ll be 
playing the exact same game as the computer version of 
Roblox. You can still play using a keyboard and mouse or 
gamepad.

*  *  * 

�Now you’ve got an account, know how to check out 
different things on the website, and have a better under-
standing of how to play Roblox using different devices. 
Let’s move on to the fun stuff—playing games!
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�Now that you have set up a Roblox account, 
you can start playing some games. In this 
chapter we’ll cover how to customize your 

avatar and make it stand out more as your own, 
how to find games in Roblox and get started with 
actually playing games, using Robux, joining the 
Builders Club, understanding Player Points and 
badges, and interacting with other users.
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�CUSTOMIZING YOUR AVATAR

�Your avatar in Roblox is your digital character within the 
game. In every game you play, everyone you see will recog-
nize you based on your avatar. Your username will also float 
above your avatar’s head at all times. So you want your av-
atar to say something about who you are and what you like. 

Once you’ve logged in to the Roblox homepage, you 
can click the icon of your avatar, which is located on the left 
side of the page. From here you will see the Profile page 
that we discussed in Chapter 1. In addition to viewing your 
avatar, you can also make changes such as the color of 
the skin, the facial expression, and clothing. Changing the 
hat, shirt, and pants are the most common ways people 
differentiate themselves and add more detailed forms of 
customization to their avatar.

�THE CATALOG
The most popular way of getting new items for your 

characters to wear will be through the in-game Catalog. 
At the top of the screen on your main homepage you’ll see 
a navigation bar that says Games, Catalog, Develop, and 
Robux. Let’s focus on Catalog for now. 

You need Robux to buy most of the items in the Cata-
log. The price of each item is clearly labeled. You can get 
Robux only by selling and trading items to other players or 
by spending real money to get Robux. There are a hand-
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ful of free items available in the Catalog, but there aren’t 
many free items and most of them aren’t very desirable. 
Every once in a while you can win customization items from 
inside Roblox games.

�ROBUX AND THE BUILDERS CLUB

�You don’t need to spend real money to buy Robux or join 
the Builders Club. But money certainly helps make some 
things easier, lets you buy special items, and expands your 
access to new features. Think of it like you would most mo-
bile games: you can play the basic game for free, but some 
of the cooler content is only for players who pay money. 
That’s how Roblox is too.

�ROBUX
Robux is a digital currency used exclusively in Roblox 

to purchase items in games, gain access to premium game 
content, and trade between players. You get Robux by 
paying actual money to the creators of Roblox or by selling 
special items to players. The most common way to get Ro-
bux is by joining the the Builders Club, which is explained 
next, or by buying large sums of it with real money. If you 
make games in Roblox and charge players for special fea-
tures then you can actually exchange your Robux for real 
money too. You can read more about that in Chapter 14.
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�THE BUILDERS CLUB
If you and your parents think it’s a good idea, you can 

become a paying member of the Builders Club. Paid mem-
bers choose one of three different tiers that each provide 
daily and monthly rewards. One of the benefits includes a 
daily allowance of Robux. You can use those Robux to buy 
items from the Catalog or even purchase Game Passes and 
access to premium Roblox games.

�Roblox Corporation

�ROBLOX BUILDERS CLUB PROGRAM.
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�All three of the paid tiers give you the same benefits: 
all ads are gone, you can sell items, and you can create 
groups. But each membership tier is different in how many 
Daily Robux you get and how many groups you can join 
and create. There are four types of Roblox memberships in 
the Builders Club: 

�Free
If you just made an account, then you’re automatical-

ly placed in the Free membership tier. As a Free member 
you can play games and publish your own basic games, but 
you’re limited in the more advanced features of using Ro-
blox. As a Free member you don’t get any Daily Robux for 
purchasing premium items, you’ll have to deal with ads in 
the game and website, you can’t create groups, you can’t 
sell stuff, and you don’t get any bonus gear, among plenty 
of other things.

�Classic 
For the Classic tier, which costs $5.95 per month, you 

get access to groups and R$15 Daily Robux. 

�Turbo
The third tier of access is called Turbo. For a fee of $11.95 

per month you get all of the same bonuses as the Classic 
tier, plus more group access, and R$35 Daily Robux.
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�Outrageous
Outrageous, the fourth and most expensive tier, costs 

$19.95 per month and includes all of the same bonuses as the 
Turbo tier, plus more group access, and R$60 Daily Robux.

�What Are Game Passes?
�Some games have optional items and services that you can 
purchase using Robux to make the game easier or more fun. 
They work much like in-app purchases in mobile games or 
downloadable content (DLC) in other video games. For ex-
ample, you might be able to get a game pass to build better 
buildings in a city making game or give your character in-
finite lives in an Obby (the nickname for an obstacle course 
in Roblox).

�JOINING THE BUILDERS CLUB
As you can see, the benefits of membership get better 

as the cost goes up. Whether or not the different types of 
paid memberships are worth the monthly cost is entirely up 
to you, and which tier you choose depends on what you 
and your parents decide. If you want to play Roblox mostly 
for free, and only want to buy a few Robux on occasion for 
something very specific, then the Free tier is a good choice. 
But if you want to use Robux more often or enjoy bigger 
perks like creating groups, selling items, and more, then you 
need to become a paying member of the Builders Club.
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As a reminder, to join the Builders Club, you can sign up 
for one of the three paid options (your parents can pay by the 
month or annually). The more expensive the tier, the better 
rewards you receive. If you sign up as a paid member you get:

•	 �A daily allowance of Robux in your account
•	 �The ability to join more groups
•	 �The ability to create groups
•	 �100 Robux (R$100) as a bonus for signing up (first-

time members only)
•	 �Paid access option, which lets you charge users to 

play the games you create
•	 �Zero advertisements
•	 �The ability to sell items and accessories
•	 �A virtual hat
•	 �Bonus gear
•	 �The option to experience beta features before they release
•	 �The ability to trade items with other users

Even if you decide not to join, you can still have a blast 
on the Roblox website.

�PLAYING ROBLOX GAMES

�Tons of people who log on to play Roblox don’t make game 
worlds themselves—they just play other people’s games. 
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Reportedly, of the 30 million active monthly users who play 
Roblox every month, only about 500,000 of them are mak-
ing games and other items. Roblox users have already cre-
ated thousands of games on the site—chances are, there’s 
something out there in Roblox based on your favorite ex-
isting video game franchises, movies, TV shows, and more.

�FINDING GAMES TO PLAY
The only “problem” with playing other people’s games 

is that there are thousands of games to choose from! Which 
ones should you play? When you visit your homepage, you 
will find a list of games other people have been playing 
recently, as well as a few games Roblox thinks you might 
like to play. But if you click the Games tab at the top of the 
website, you can start browsing the full selection.

�BROWSING BY CATEGORY 
The Games page of the Roblox website is separated 

into a few different categories:

•	 �A constantly updated list of what’s Popular among 
players right now. Tens of thousands of people are 
probably actively playing those games right now! 

•	 �The Recommended games are those that are se-
lected based on past things you’ve played and inter-
ests you’ve shown. It’s kind of like your own special, 
personal list that’s made just for you.
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•	 �The Top Earning games are those games that peo-
ple are spending the most Robux on while playing. 

•	 �The Top Rated games are the games that players 
consider to be the best. This category shows you 
the games that people have decided they like the 
best recently. After playing a game, you can leave a 
rating too.

•	 �Featured games, which are games selected by 
the creators of Roblox. They are usually suggested 
based on what’s trending online at the moment. 

At the far right side of every row is a blue See All but-
ton. When you click that, it takes you to a page that’s filled 
just with the types of games in that category, such as only 
Popular games or only Featured games. 

At the top of the main Games page, there are two drop-
down menus. Use these menus to get more options in-
stead of what the regular selection shows. The drop-down 
menu on the left should say Default, and if you click it then 
you’ll find a whole bunch of other choices, such as Friend 
Activity for games your friends are playing or Popular in 
VR, which lists games people like to play while wearing a 
virtual reality headset.

The other drop-down menu should say All. Click it, and 
you’ll see a list of genre categories like Adventure and Mili-
tary. One of the easiest and fastest ways to pick something 
to play on Roblox is to use the All drop-down menu. Just 
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pick a type of game that sounds fun to you and click. For 
example, if you like knights and castles, choose the Medi-
eval category. If you’d rather play some soccer, football, or 
basketball, look in Sports. By clicking each of these genres 
you’ll see a list of the best and most popular games in each 
category. From there, just pick a game and try it! 

�USING THE SEARCH BAR
You’re not limited to just browsing lists under category 

titles though; you can also use the Search bar at the top of 
the Games page. For example, if you wanted to play Ro-
blox games about Pokémon or SpongeBob SquarePants, 
you’d just type that term into the Search bar and press 
Enter or Return on your keyboard. See what comes up and 
then select a game.

As an experiment, let’s search for Pokémon.

�Roblox Corporation

�LIST OF THE TOP POKÉMON GAMES YOU COULD PLAY.

Project: Pokemon
757 Playing

[Arcade]Pokemon . . .
3,611 Playing

ROBLOX Pokemon . . .
44 Playing

Pokemon Tycoon!
56 Playing

Pokemon Adventur . . .
23 Playing

Pokemon Galaxy
21 Playing

[GRENINJA!] Pokem . . .
130 Playing

[DESC] Pokemon Fi . . .
358 Playing

Pokemon Arena X
3 Playing

[Content Deleted] Pokemon Universe
51 Playing

Pokemon Battle-Br . . .
13 Playing

Pokemon Advanced
6 Playing

Pokemon GO!
15 Playing



CHAPTER 2: FIRST STEPS  49

�Immediately a whole bunch of Pokémon games appear. 
As you can see, at the time of this search there were thou-
sands of people playing Pokémon games on Roblox. The 
most popular game in this bunch appears to be Pokémon 
Brick Bronze, with over 3,000 active players. 

In case you’re wondering, Pokémon Brick Bronze is a 
lot like Nintendo Gameboy, DS, and 3DS Pokémon games. 
You make a character, move through regions, battle other 
trainers and gym leaders, and find and capture new breeds 
of Pokémon along the way. Battles even take place with 
each side taking turns, just like in the official games.

�Pokémon Brick Bronze Version

�A BATTLE IN POKÉMON BRICK BRONZE.

�This particular game is pretty amazing. It’s really hard to 
make a game this good!
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�THE BEST ROBLOX GAMES

�Since there are thousands of games to play on Roblox, it can 
be tough to pick just one. Lots of the games made by begin-
ners aren’t super fun to play because it was their first try, but 
there are still a bunch of great ones. To give you someplace 
to start, I made this list of eight of the best games you can 
play in Roblox. Six of the games are totally free and the oth-
er two cost a small number of Robux to play.

�POKÉMON BRICK BRONZE
This game lets you pick a starting Pokémon and engage 

in battles as you adventure across a vast world, just like you 
do in the popular Nintendo games. 

��This is also one of the only Pokémon games that lets 
you roam around and interact with other people online 
while playing. Most other official Pokémon games can only 
be played alone offline unless you’re battling someone. 
Pokémon Brick Bronze is one of the most popular Roblox 
games.

�THEME PARK TYCOON 2
One of the most popular types of games on Roblox are 

simulation or tycoon-style experiences. That means that 
you pretend to run a business or build something and op-
erate it to make money. It’s fun to slowly grow your busi-
ness to see if you can make it successful!
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�In Theme Park Tycoon 2 you get to build an entire theme 
park however you want. You try to keep your customers 
happy by providing them with food and beverages, as well 
as a good mix of intense rides, gentle rides, roller coasters, 
water rides, and more. 

�EPIC MINIGAMES
Epic Minigames is just a group of simple and fun games. 

��There are more than sixty minigames within Epic Mini-
games so far, and as you play you earn points each time 
you beat a level. All of the points and levels you gain can 
be used to get yourself special gear, abilities, and even 
pets within the Epic Minigames game world. Out of all 
of the games on Roblox, this one probably has the most 
diverse selection of activities. Other games let you shoot 
monsters, race cars, or build things, but Epic Minigames 
has a little bit of everything.

�JAILBREAK
Do you and your friends ever play Cops and Robbers? 

That’s the general idea behind Jailbreak. Players join into 
the game world and have to try and get away with robber-
ies and other crimes without getting caught.

�What makes Jailbreak so fun is just how big the world 
is and how action-packed it is from start to finish. Driving 
around a large city as you try to rob banks and jewelry 
stores is really exciting. 
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�PHANTOM FORCES
Phantom Forces is one of the most advanced games on 

Roblox. If you have experience playing first-person shooter 
games like Counter-Strike and Call of Duty, you might like 
this game.

��Instead of seeing your character from the third-person 
perspective like in most other Roblox games, everything 
in Phantom Forces is first person, meaning it’s like you’re 
looking at the scene with your own eyes. The point of the 
game is to battle against other players in team-based con-
tests. There is some blood and a lot of violence so it’s not 
recommended for younger players. Check with your par-
ents to be sure it’s a good choice for you before you play.

�ZOMBIE RUSH
Zombie Rush is fun because you can keep coming back 

and playing over and over and still have fun each time. 
It’s a multiplayer game, so you can play with friends, and 
you can actually grow your character by leveling up and 
increasing their stats.

�The idea behind the game is that you and a group of 
other players have to fight off waves of zombies as they 
slowly surround you. If you fall, you can change it up and 
play as a zombie. The zombies are pretty gross, so if that 
sort of thing bothers you, then this game might not be a 
good choice.
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�RESTAURANT TYCOON
Have you ever wanted to run your own restaurant? 

Restaurant Tycoon is a paid game (you need to spend 25 
Robux to unlock access) and it’s kind of like Theme Park 
Tycoon 2. 

��The main difference between Restaurant Tycoon and 
Theme Park Tycoon 2 is that that this time you’re manag-
ing restaurants. You have to pick different foods to serve 
instead of putting theme park pieces together. You also 
keep track of orders and give assignments to cooks and 
waiters. It’s a ton of fun and makes you see real-life restau-
rants in a totally different way! 

�WELCOME TO BLOXBURG
Welcome to Bloxburg requires you to pay 25 Robux in 

order to play it. 
��This game is sort of like living a life on your comput-

er. You get to build a house, own cars, go to work, hang 
out with friends, and explore the bustling city of Bloxburg. 
There are a lot of games in Roblox where you can hang out 
with friends, but Welcome to Bloxburg is one of the best 
because it actually has fun things to do other than just sit-
ting around and talking to people. It’s like you get to make 
a whole new life in a little virtual Roblox world. It’s kind of 
like The Sims, but with a ton of other people in the same 
city with you.
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�UNDERSTANDING THE IN-GAME 
INTERFACE

�Every game you play in Roblox will have a different set of 
controls that are designed for that particular game. For ex-
ample, a game about building things will have you using 
the mouse to click things on the screen a lot, but a racing 
game will have you pressing buttons on the keyboard to 
move around and drive the car instead. Generally speaking:

•	 �If you are playing an obstacle course platforming 
game (commonly referred to as an Obby), then you 
should expect to see your whole character as you 
play, running and jumping on platforms, and avoid-
ing obstacles.

•	 �A first-person shooter (games like Call of Duty or 
Counter-Strike) would have you controlling your play-
er as if you’re seeing everything through your own 
eyes. So you might only see your hands or what’s in 
front of you.

•	 �A superhero-themed action game or a game in-
spired by Pokémon allows you to see your character 
from above, like you’re floating in the sky. 

Basically, the controls of the game will match whatever 
type of game you’re playing.
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�What Are Player Points and Badges?
�Some games award you with Player Points when you complete ob-
jectives within the game. These points are simply used to display 
your expertise with a game on a leaderboard and are not related 
to Robux in any way. Badges are similar, like achievements.

�NAVIGATING THE OPTIONS MENU
One of the things that’s the same in every Roblox game is 

the Options menu. When playing on a computer, all you have 
to do is press the Esc key to bring up the Options menu.

�Roblox Corporation

�OPTIONS MENU.
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�At the top of this box, you’ll see various different options.

�Players
On the far left is the Players tab, which isn’t selected in this 

screenshot. The list of names under the Players tab gives you 
options to send a friend request to another player or report an 
issue (such as abuse of the game or bullying) to the developers. 

�Settings
Settings is where you can make minor adjustments to 

things like volume levels and how detailed the graphics are. 
If everything in the game is running fine, then you won’t 
have any need for this menu. If the game is running slowly or 
keeps freezing, you may want to lower the graphics quality.

�Report
The Report section, next to the little flag icon, is where 

you can write to the Roblox website if you’re having a prob-
lem you can’t fix yourself. For example, you can enter a 
specific player’s username if that person hasn’t been play-
ing a game right. Or you can tell them about a broken fea-
ture (called a “bug”) on the website or in a game.

�Help
When you click Help you’ll see a menu full of controls for 

whichever game you’re playing. You should always check out 
this menu before you play a new game. 
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�Record
The Record option allows you to save memories from 

when you play with friends and document things that hap-
pen inside Roblox games. If something crazy happens, 
you’ll want to keep track of it! It has a button for taking a 
screenshot (it will be saved in the default location of This 
PC > Pictures > Roblox on your computer). When you click 
Record Video, it will save the video file to that same folder 
so you can edit it (if you want) or upload it to a video shar-
ing website like YouTube.

�Leaderboards
In the top right corner of the screen for most games in 

Roblox you should see a list of usernames with a number 
next to each name. This is the active leaderboard, and it lists 
current players in the game who have the highest score.

That isn’t the case for all games, though. Instead of listing 
users in the top right corner at all times, some games may 
have them displayed only when you press a certain button, 
such as Tab. Other games have a list of users who have died, 
or a score that pops up once in a while to keep you updated.

�PLAYING WITH OTHER PEOPLE

�When you’re playing a game in Roblox, there will be other 
people playing the same game with you at the exact same 
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time. You can see them walking around with names float-
ing over their heads as they play. Let’s talk about different 
ways you can talk to or play with those other users. 

�THE CHAT BOX
While playing a game in Roblox, you’ll see a message 

box in the top left corner that can be used to talk with the 
other users who are playing the same game. To send a mes-
sage, click the chat box or press the / (slash) key on your 
keyboard, type your message, and press Enter or Return. If 
you’re playing with friends, then communicating about strat-
egies is important, and you might want to invite people to 
your personal place in Roblox to hang out and chat.

�ADDING FRIENDS
Sometimes when you’re playing you might come across 

a player who is fun to play with. If your parents agree that 
it’s okay, you may want to add them as a friend in Roblox. 
This works a lot like adding friends on social media sites 
such as Facebook, Twitter, and elsewhere. 

When you’re in a game, just enter the Options menu by 
pressing the Esc key or by clicking the square three-bar icon in 
the top left corner of the screen. Click the Players tab. Beside 
the name of each player in the game is a button labeled Add 
Friend. If you click Add Friend, a little box will pop up on their 
screen asking if they want to accept you as a friend. The same 
happens to you if another player tries to add you as a friend.
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Once someone is your friend then you can see when 
they’re online, what they’re playing, and send them direct 
messages that they can read and respond to even if they 
aren’t actively playing a game in Roblox at that moment. 
It’s sort of like an email, but it’s directly tied to Roblox and 
Roblox accounts.

�REPORTING PEOPLE WHO AREN’T PLAYING 
	 RIGHT

Most of the time when you’re playing Roblox, every-
thing will be great. However, once in a while you’ll run into 
someone who is clearly ruining the game for everyone else. 
And in that case you should report that player immediately. 

Here are some of the warning signs to look out for. Look 
for players who are:

•	 �Swearing in the chat box
•	 �Messaging you constantly and not leaving you alone
•	 �Asking you for your personal information or account 

details
•	 �Making it difficult for you to play the game

If you are having any one of these issues with a player in 
the game, you can report that player. You do this by going 
to the Options menu and clicking the Report tab. Pick the 
player’s name from the game and submit a synopsis of the 
issue.
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Keep in mind though that reporting a player is basically 
the same as telling your teacher about someone misbehav-
ing in school. You should only do it if the person is really 
out of line. If someone in the chat disagrees with you about 
something or is beating you at the game, those aren’t good 
reasons to report them. 

*  *  * 

�Now that you’ve fooled around playing other people’s 
games, you can try to build your very own world. Coming 
up next is Part 2, where you will learn all there is to learn 
about creating games in Roblox.
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�P laying other people’s Roblox games is defi-
nitely a blast, but what if you want to make 
your own game? You’ll have to use the Ro-

blox Studio for that. (Right now, Roblox Studio 
only works on computers. It does not work on 
smartphones, tablets, or game consoles.) It’s a 
program that has tons of options for you to cus-
tomize your game however you like!

If you’ve played a Roblox game in the past, 
there’s a good chance that Roblox Studio is al-
ready installed on your computer. You’ll probably 
be able to find the icon on your computer’s desk-
top. Just click that to open up Roblox Studio. If 
not, click Develop at the top of the Roblox website 
to go to the page that lets you download Roblox 
Studio, or just visit this website: www.roblox.com/
develop. Follow the instructions shown to install it 
on your computer. 
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�UNDERSTANDING ROBLOX STUDIO

�When you open up Roblox Studio for the first time, you’ll 
see that there’s a ton going on. There are lots of options 
to pick from, menus around the sides of the screen, and a 
whole bunch of resources there too. This is the same pro-
gram thousands of people have used to make all of your 
favorite Roblox games! Now it’s your turn.

Roblox Studio should look something like this:

�Roblox Corporation

�THE START PAGE FOR ROBLOX STUDIO.

�This is called the Start Page. Every time you open Rob-
lox Studio you’ll see a page that looks a lot like this. New 
Project is probably selected on the left-hand side, but there 
are also sections for Games (where your finished games 
will be) and My Projects (where all of your work-in-progress 
games will be until you finish them).
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�THE HOME MENU

�At the very top of the screen is the menu bar with a bunch of 
submenus such as File on the far left, followed by Home, Mod-
el, and others after that. The default starting menu is Home.
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�Roblox Corporation

�THE HOME MENU FOR ROBLOX STUDIO.

�The far left of the Home menu has all sorts of basic 
tools you’ll need, such as the following. 
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�CLIPBOARD
This section has icons that deal with the clipboard, or 

how you can cut, copy, paste, or duplicate things inside 
Roblox Studio, sort of like when you’re typing on a comput-
er or texting on your phone. You can use these options to 
copy objects inside the game you’re building (to make an-
other object), as well as to cut items (to delete an object). 
After you’ve copied or cut something you can use Paste to 
then display that object again. 

�TOOLS
To the right of the Clipboard icons are the Tool icons. 

Select is used to pick something, like a car or tree to use in 
your game, while Move is used if you want to actually move 
an object around after selecting it. Scale is used to change 
an object’s size, while Rotate lets you spin and twist an 
object around to face different directions by dragging dif-
ferent colored orbs to reposition it in the game world.

�Roblox Corporation

�ROTATING A SOLDIER INSIDE ROBLOX STUDIO.
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�Next to the Rotate option is a button called Collisions. If 
this is turned on, then when you have objects in your game 
world, such as a soldier and a building behind him, the two 
objects cannot overlap into each other on the screen. A 
collision means that they’ll have a crash and stop! Finally, 
the Join option lets you decide if objects are always joined 
together or only sometimes or never.

�INSERT
The next section, Insert, is tiny but very useful. If you 

click on Toolbox, this will open up the Toolbox panel on the 
left side of Roblox Studio. The Toolbox contains hundreds 
of premade things that are completely free to use in your 
Roblox games, from cars and houses to zombies and robots.

�Roblox Corporation

THE TOOLBOX FEATURE INSIDE ROBLOX STUDIO.

�At the top left of the Toolbox is 
a drop-down menu you can click on 
to reveal a bunch of different catego-
ries like Models, Decals, and Audio. 
There are a bunch of other catego-
ries in there too. It’s definitely easiest 
to grab one of these items then cus-
tomize it for your game.

All you have to do is pick a cate-
gory then type into the search field 
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whatever you’re looking for. If you want a house, just type 
in house and pick from the list of results. Some of the hous-
es might say Free, but all of them are actually free to use. 
You’ll also notice some of them have a small orange icon, 
which means the creators of Roblox decided to mark that 
one as a “high-quality” item.

Roblox Corporation

�SEARCHING FOR A HOUSE IN THE TOOLBOX.

�Back up in the Insert section of 
the Home menu in Roblox Studio, to 
the right of the Toolbox icon, is an 
icon that just says Part with a little ar-
row below it. When you click on this 
icon you’ll get four different options: 
Block, Sphere, Wedge, and Cylinder. 
You can think of these as the building 
blocks for pretty much everything in 
Roblox. If you want to make some-
thing from scratch—say, a house—

then you can probably do it using a variety of these different 
parts and very carefully placing them all together. 

�EDIT
The next section to the right is Edit, which is where you 

can make changes to things inside the game world. The 
Material icon lets you change what objects are made out 
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of. For example, you could click on a wooden box, then go 
into the Material setting to make it look like a box made 
out of bricks. Next to Material is Color. Use Color to change 
the color of an item. 

�Using the Toolbox
�The toolbox in Roblox Studio is super helpful because it’s 
packed full of amazing and high-quality stuff that you 
don’t have to make from scratch! One thing to think about, 
though: If your game is built using only toolbox resources, 
people will be less likely to play it because it isn’t origi-
nal. Make changes to Toolbox items and create your own 
objects to add variety. Then your game will be as unique as 
you are!

Finally, in Edit there’s Group, Ungroup, and Anchor. 
Click and drag your cursor to select multiple things, and 
then click Group. Doing so will make sure that all of those 
objects stay together when you move them. Ungroup does 
the opposite by separating everything instead. Anchor is a 
little different because it actually prevents an object from 
moving anywhere. 

�An Example of Making Edits
As an example of putting all of these things together, 

look at our soldier again from a previous photo. See how 
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his shirt and pants are green, like a lot of people in the 
military usually wear? Let’s give him a black shirt and blue 
pants instead so it doesn’t just look like the Toolbox ver-
sion of a soldier.

To do that, you’ll have to start by just clicking on him 
to select him. Then go up to the Edit section and click 
Ungroup so all of his individual parts are separated. That’s 
right, you can change only certain parts of a character’s 
body! Now you can pick specific pieces of the soldier like 
his arms, his face, his body, etc. Click his upper body where 
his shirt is to select it. Now go back up to the Edit section, 
click on Color, and pick black. And now he has on a black 
shirt! Then click each leg and select a blue color to give 
him blue pants instead of green ones. 

�Roblox Corporation

�THE SOLDIER NOW HAS A BLACK SHIRT AND BLUE PANTS.

�By following those steps it’s incredibly easy to make 
changes to other things you get from the Toolbox while 
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making a game. If you’re building a racing game, for exam-
ple, you can easily change the color and material of cars to 
make them look cooler, or you can make people in a crowd 
all look different so a scene is more realistic. These kinds of 
changes will make your game more fun to play.

�TERRAIN
The Terrain section of the Home menu might be grayed 

out for you (meaning you’re unable to use it) if you’re work-
ing in a project that already has terrain. But if it’s a new 
project, then you should be able to use the features in this 
section. The Terrain feature in Roblox lets you make your 
game’s world look however you want it to. We’ll cover that 
feature in more detail later in this chapter.

�TEST
At the far right of the Home menu is the Test section. 

Once you’ve got enough stuff in your game to warrant 
actually jumping in and testing it out, you just click the 
Test button. Your character will plop down into the game 
and you can run around like you would in any other Rob-
lox game. The Play Here option lets you more specifically 
determine where gameplay starts for your testing. The Run 
option makes the game start going without dropping your 
character into the world. This is a good choice if you just 
want to see how things play out on their own. Finally, you 
can click Stop to end your testing.
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�NAVIGATING ROBLOX STUDIO

�Besides figuring out the details of your game (like how 
to change a character’s outfit or add a house), you’ll also 
need to know how to move around your world to build and 
change things. 

Since you’re not controlling a character when you’re 
working in Roblox Studio, think of it like you’re actually 
controlling an invisible camera that’s pointing into your 
game world. When Roblox Studio is open, you can move 
the camera around using the W, A, S, and D keys, just like 
you do when playing a game in Roblox. You can also click 
the left mouse button while pressing the Ctrl key to se-
lect multiple objects, and you can click and drag the right 
mouse to rotate and spin the camera around. Rolling the 
mouse wheel lets you zoom in and out.

As you play around more in Roblox Studio, you’ll pick 
up on different shortcuts you can use so that you don’t 
have to sift through the menus to do every little thing. 

�THE MODEL MENU

�Most of the time you shouldn’t need to switch to another 
submenu because the Home menu has almost everything 
you’ll need all in one place. But sometimes other menus 
have tools you’ll need.
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�Roblox Corporation

�THE MODEL MENU FOR ROBLOX STUDIO.
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�The Model menu is located to the right of the Home 
menu. The first section on the Model menu is called Tools 
and it’s mostly the same as the Tools section of the Home 
menu. However, the main difference is that you now also 
have a Transform option, as well as Lock and Join options. 
You probably won’t need to use any of these as they are 
really just more complicated versions of other features like 
Scale and Group.

After Tools is the Snap to Grid section, which you really 
only need if you’re doing advanced creation. When you se-
lect an object in Roblox Studio, do you see all of those little 
gridlines that appear at the bottom? These options let you 
assign the exact position and angle of objects in the world. 
Snap to Grid helps you use the world’s invisible gridlines to 
position your objects. You can ignore it for now, though.

The rest of the options in the Model menu, such as Sol-
id Modeling, Constraints, Gameplay, and Advanced, will all 
be covered as needed in later chapters. For now you can 
ignore those options on the Model menu.

�THE TERRAIN MENU

The Terrain menu is located to the right of the Model menu. 
The Terrain menu is one of my favorite features of Roblox 
Studio to play around with because you can make huge 
changes to your game really quickly. If you want to make a 
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game that has a more realistic look to it, as opposed to the 
blocky designs that most Roblox worlds have, then you’ll 
want to use the Terrain features.
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�Roblox Corporation

�THE TERRAIN MENU FOR ROBLOX STUDIO.

The Terrain menu is simple because all of its options fall 
under the same section. To get started, pick the one that 
says Generate. A pop-up window will appear with a set of 
options. Stick with a Map Size that is Medium, and then 
select the different geographical regions, or Biomes, you 
want to see. For example, I selected Water, Plains, Hills, 
and Mountains. Once you’re done, click Generate and 
watch the magic happen. 

While Roblox Studio creates your world, you can zoom 
out and look around during the process. Areas that were 
once flat will now have hills. Dry grass will have a river 
streaking through it in the middle, and the flat terrain will 
be peppered with hills and rock-crested mountains. It will 
look like an actual environment, like something in a real 
game. 
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�Roblox Corporation

�DETAILED TERRAIN IN ROBLOX STUDIO.

�Try doing that one more time, but this time select differ-
ent Biome types. For example, this time I want to mix things 
up a bit more by selecting Dunes, Canyons, Mountains, and 
Lavascape. Click Generate and watch it work once again.

�Roblox Corporation

�TERRAIN WITH MORE VARIETY IN ROBLOX STUDIO.
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�See the difference? By changing your options in the 
Terrain generator, you can get an entirely new area for your 
game. But that just covers how to randomly create an area. 
Now it’s time we dig in and start altering it:

•	 �Add: If you click the Add icon, then you can choose 
from an orb or a cube shape, Size and Strength op-
tions, and a list of terrain types. Pick a terrain type 
(such as the default, Grass), and click the left mouse 
button somewhere on the terrain. Wherever your 
orb (or cube) is located, the tool will add the se-
lected terrain there. Floating balls of earth in the 
sky look weird, but if you use it on the land to add 
hills and mountains, it makes more sense. This is 
also a great way to add more environmental variety 
with the other materials such as Sand, Water, Snow, 
and Ice.

•	 �Subtract: In the Terrain menu you can also use the 
Subtract option, which does the opposite of the 
Add option. Just hover your mouse over the area 
you want to decrease, click the left mouse button, 
and move the mouse around. It works kind of like a 
vacuum sucking away the terrain.

•	 �Paint: The Paint option uses the material you select 
to create a layer on top of the world. It works just like 
a paintbrush. This is useful if you want a mountain to 
have snow only on its very top, for example.
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•	 �Grow and Erode: The Grow and Erode options work 
similarly to the Add and Subtract options, although 
they aren’t as extreme. Instead of adding big chunks 
of terrain, you use these options to slowly increase 
or decrease areas that are already there. 

�Roblox Corporation

�A SMALL HILL MADE USING THE GROW OPTION IN ROBLOX STUDIO.

•	 �Smooth: The Smooth feature is good to use after 
you’ve applied the others because it can help make 
things look much more natural. For example, if your 
mountain or hill is lumpy or you subtracted too much 
terrain and left your ground looking pointy, then you 
can use the Smooth tool to fix it.
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•	 �Regions: Finally, there’s the Regions option. With this 
tool, you can select entire sections of the terrain and 
then move, copy, resize, or rotate them as you see fit.

Out of all of the things you can do in Roblox Studio, 
the Terrain features are the easiest to understand...but 
the most difficult to get really good at. You might put in a 
mountain, then decide it doesn’t look right and delete it. 
You’ll get better and better at it the more you practice.

�THE TEST MENU

HOME MODELFILE TERRAIN TEST VIEW PLUGINS
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�Roblox Corporation

�THE TEST MENU FOR ROBLOX STUDIO.

�Once you get your game up and running as something 
that’s actually playable (we’ll cover making games a little 
bit later), then you can worry about the Test menu more. 
So for now, we’ll keep this brief.

•	 �Simulation: On the far left is the Simulation section. 
You can review the full game with the same Play, 
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Play Here, and Run options you had on the Home 
menu, but there are a bunch of other choices now 
too. The very next one is Run Script, which lets you 
start a specific script that’s prepared for the game. 
We’ll get into script writing more in a later chapter, 
but for now it’s enough to know that scripts are ba-
sically like a list of rules and orders for the comput-
er to follow. Then there’s Pause, which will suspend 
the game as it is, just like when you pause a movie, 
and then there’s Stop, which is the same feature as 
on the Home menu. The rest of the Test menu gets 
pretty complicated. Here’s what it can do:

•	 �Clients and Servers: To the right of Simulation is 
the Clients and Servers section, which is where you 
can do testing with other people if your game is go-
ing to be a multiplayer game. 

•	 �Emulation: After that is the Emulation section, which 
can help you test your game on other platforms other 
than the computer, such as on smartphones and tablets. 

•	 �Audio: Then there’s the Audio section, which 
handles—yep, the sound!

•	 �Analyze: The Analyze section is where you can see 
how the physics are impacting the game’s perfor-
mance. If you have too much stuff going on at one 
time, like a bunch of explosions or too many ene-
mies on-screen, then it could cause the game to 
slow down for players.
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�THE VIEW MENU
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Roblox Corporation

�THE VIEW MENU FOR ROBLOX STUDIO.

�Next up is the View menu, which has a whole lot going on, 
as you can see. Let’s look at the different sections.

�SHOW
A lot of the icons on this menu just turn on different sec-

tions of Roblox Studio for you to see (or not see) while you’re 
building your game. That’s why the Show section of the View 
menu is so huge! Those are all of the things that can be shown.
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For example, clicking Explorer will hide the Explorer 
panel, which is probably set to appear on the right side 
of your screen. That panel shows you where everything is 
saved in your project, in which file, in what order, and so 
on. You might not need to look at that all the time—if you 
don’t want it cluttering up your screen, just hide it. 
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�Roblox Corporation

�THE EXPLORER PANEL.

�Next to that is Properties, 
and clicking it will hide the 
Properties panel (it typical-
ly displays on the right side 
too, below the Explorer pan-
el). Properties breaks down 
everything you need to know 
about the selected object or 
item within the game world. 
For example, it will tell you 

how large something is or which pieces were used to make it.
If you want to be taken back to the homepage for Rob-

lox Studio, the one that you saw when you first opened the 
program, that’s what the Start Page link will do. 

There are even built-in tutorials within Roblox Studio 
to help you get acquainted with its features. You can keep 
one of those panels open while you work to learn more 
about the program. 
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Tutorials

Making a Game Making a Tree Making a Door

Tutorials
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�Roblox Corporation

�VARIOUS TUTORIALS.

�The rest of these options, like Script Analysis, Call Stack, 
and Script Performance, are things you’ll learn about once 
you get good at making games.

�ACTIONS
In the Actions section, you can do some really neat stuff. 

For example, if you click Full Screen, you will actually make 
the Roblox Studio program take up your entire screen, so 
you can see as much information as possible. The Screen 
Shot icon will let you grab a screenshot of your game in 
action, while clicking the Video Record icon will record a 
quick video for you. Display Axis simply shows you the gri-
dlines. You can ignore it.
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�SETTINGS AND STATS MENUS
The rest of the View menu consists of more complex 

stuff in the Settings and Stats sections. You won’t need to 
worry about these sections as you create your first games.

�THE PLUGINS MENU
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�Roblox Corporation

�THE PLUGINS MENU FOR ROBLOX STUDIO.

�The final menu of the bar at the top of the Roblox Studio 
screen is the Plugins menu. This menu covers even more 
advanced features inside of Roblox Studio that you’ll be 
able to master later. For now, we will cover just the basics 
of what they do.

A “plugin” is an extra feature you can use to enhance 
your game while you’re making it. Here’s what Roblox 
Studio allows you to do with plugins:

•	 �Tools: At the Roblox website and on the forums, you 
will be able to find plugins that you can use with 
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your game to do a wide range of different things. 
By clicking Manage Plugins you can find new plugins 
to use and adjust the currently installed plugins for 
your game. Click the Plugins Folder to see where all 
of your plugins are stored. If you’re new to Roblox 
and Roblox Studio, then you probably won’t have 
any plugins to view just yet.

•	 �Animations: In the Animations section there is an 
Animation Editor option as well as a Rig Builder op-
tion. When you use the Animation Editor, you can 
create specific actions and motions that you want 
characters and objects to perform in your game. 
For example, you could use the Animation Editor 
to make a soldier (like the one from earlier in this 
chapter) flail his arms around while running away. It 
takes a lot of practice to do animations well because 
you have to spend a lot of time fooling around with 
models and characters, so it’s not easy to just pick 
up and do. Still, it’s fun to just play around with an-
imations to make your characters do funny things. 

Finally is the Rig Builder, which is useful for making new 
objects and characters that are specifically to be animated. 
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*  *  * 

�That just about covers it for getting to know the basics 
of Roblox Studio! It’s a really cool program that has a lot 
more power than you’d think at first. You’ll be jumping in 
and out of these menus like it’s nothing in no time. Now 
that you know what the tools do, you can use them to 
make a game.
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�Once you get the hang of it, using Roblox 
Studio to make a game is easy. Sometimes, 
the hardest part is figuring out what your 

game should be! When you’re starting out, don’t 
be afraid to try different things to see what ends 
up being fun. Don’t worry if you make a game 
that doesn’t work out—that happens to even 
the best game developers! Just try again. Every 
game you make will give you more experience 
and more practice...and that’s the best way to 
become an amazing game creator.
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�THINK OF A GAME IDEA

�One of the coolest things about Roblox is that you can 
make pretty much any kind of game you’d like. For exam-
ple, you could make an open-world adventure game like 
the Lego Batman games, or a simulation game like SimCity 
or Roller Coaster Tycoon. You can even make action games 
like The Legend of Zelda or shooting games like Call of 
Duty.

This book will teach you a handful of game ideas that 
are easy to understand and learn from, but then you can 
come up with your own ideas for a game that’s 100 percent 
unique and a blast to play.

Not all game ideas will work for Roblox though, so keep 
that in mind. For example, you probably can’t easily make 
a 2D side-scrolling platformer/obstacle game (like the orig-
inal Super Mario Bros., where the action only moves from 
side to side, not in three dimensions). Since Roblox is a 3D 
platform, that just won’t work. However, you could make a 
3D platforming game like Super Mario 64, which is similar.

Try these steps to help develop a game idea that will 
work for Roblox.

�RESEARCH OTHER GAMES
Start by thinking about the kinds of games you like to 

play. Go to Roblox and search for games like the one you 
want to make and play as many as you can. That way, you’ll 
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know what’s already out there and what other players like, 
and you’ll get a good idea of what works and what doesn’t. 
If something isn’t fun in other games that you’ve tried, it 
probably won’t be fun in the game you want to make, ei-
ther. You’ll also be able to think of what might be missing 
from the games people have already made—and you can 
add that missing thing to your game!

�WRITE DOWN YOUR IDEAS
It’s a good idea to keep track of your ideas so you don’t 

forget any. When you come up with your idea, write it down 
in a notebook or type it out. What’s the main goal of the 
game? What will players do? How is it fun? How is it similar 
or different from other games out there? Write down any 
cool ideas you don’t want to forget, even if they don’t be-
long in the game you’re currently making. They might be 
useful in another game you make!

�SEE WHAT YOUR FRIENDS THINK
You might want to ask some friends what they think 

about your idea. If they think it sounds fun, then chanc-
es are other people will too. They might have ideas on 
how to make the game even better. (Other people like to 
keep their game ideas a secret until after they’ve made the 
game—that’s fine too!)
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�GAMEBUILDING 101

�Since this is probably the first game you’ve worked on, 
don’t try to make an award-winning game right off the bat. 
Here’s how to think about the process:

1.	 Come up with your game idea 
2.	 Create a simple world for it to exist in
3.	 Build the terrain
4.	 Add characters and objects
5.	 Give your player(s) something to do

Let’s start with a simple game idea: an Obby. In Roblox, 
an Obby is a nickname for an obstacle course, or a series of 
quick challenges that require players to act quickly and time 
movements carefully. In traditional video games this is most 
commonly referred to as a platformer. Games like Mario, Son-
ic, and Crash Bandicoot are all called platformers because 
they require you to jump from one platform to the next as you 
make quick and careful movements through a level.

Making an Obby is easy, it can be a lot of fun, and it is 
one of the most common game types on Roblox. It’s per-
fect for a first game!

�THE ELEMENTS OF A GOOD OBBY IN ROBLOX
Before you make a game, it’s a good idea to think about 

its most important parts. If, for example, you gave some-
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one a new game to play and told them it’s a shooter, then 
they’re going to already know that they can probably move 
around, shoot guns, and take out bad guys and monsters 
along the way. 

So if a Roblox player comes across your game on the 
website and they see that it’s an Obby, then there are a few 
things they’ll expect right away. An Obby game in Roblox 
has a few key parts.

�Movement
Players need to be able to move and jump, just like most 

other Roblox games. In most Obby games, there aren’t any 
guns or weapons to use. Most of these games don’t even 
have that many enemies. Above all else, an Obby is about 
having the player be quick and avoid things as they try to 
reach the end.

�Obstacles
You might have guessed by now that the nickname Obby 

comes from the word obstacle, so naturally you need ob-
stacles. Those obstacles could be platforms that the player 
has to jump on, dangerous traps to avoid, large areas to 
explore, or a mixture of all three. 

�Checkpoints
Since Obby games can be very difficult, it’s important to 

give players checkpoints throughout the level. This means 
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that if they fail or die, they get to try again from the last 
checkpoint instead of being forced to start all the way from 
the beginning (that can be so annoying!). You don’t have to 
add checkpoints, but they will make the game much more 
fun for players—and will encourage them to keep playing 
it over and over again.

�Goal
Players need a reason to try to reach the end of your 

Obby. Maybe it’s a big final checkpoint at the end, a large 
platform that’s waiting for them, or a message from a char-
acter congratulating them on an awesome job. No matter 
what the ending, a good Obby makes a player feel like 
they’ve accomplished something when it’s been completed.

�CREATE A SIMPLE ROBLOX GAME IN 
FIVE EASY STEPS

�When it comes to making a game, you can do it in as little as 
five minutes or as many as five weeks. It all depends on how 
much you decide to do. Follow these five steps to turn a 
boring Roblox template into a fun game you made yourself!

�STEP 1. CHOOSE A TEMPLATE
With Roblox Studio open, make sure you’re on the stan-

dard Start Page. Select the New Project category on the 
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left. From there you should filter your Game Templates to 
either All or Gameplay. In those results, one of the options 
should be Obby. It shows an image of a bunch of blocks 
floating in the sky. Click that one to get going.

In order to quickly make your first game, there’s no 
point in starting entirely from scratch since this template 
already has a lot of the pieces in place. Why not take ad-
vantage of them?

�Keyboard and Mouse Shortcuts
�If you click and hold the right mouse button, you can rotate 
the camera around to gain a better view of everything. Use 
your mouse’s scroll wheel to zoom in and out. Using the key-
board, you can also move the camera forward with W, back-
ward with S, left with A, and to the right with D. You can 
also click on objects and menu icons using the left mouse 
button, and right-click the mouse button to see menu items.

�STEP 2. FOOL AROUND WITH THE TEMPLATE
Once the template example loads, it should look some-

thing like this image.
�There are just a few blocks floating around in the sky. 

Even though it sounds silly, go ahead and play the game 
with just this template and nothing else. Click the blue ar-
row that shows the outline of a Roblox avatar at the top 
right area of the Home section to launch the test game.
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�Roblox Corporation

�THE DEFAULT TEMPLATE FOR AN OBBY GAME.

�Playing the Obby Template Level
�All you have to do is use the W, A, S, and D keys to move your 
character and use the spacebar to jump. You can also click 
and hold the right mouse button and move the mouse to ro-
tate the camera as you play to get a better view of the lev-
el. Jump on the white blocks, avoid the red ones, and touch 
the spiral image to activate the checkpoint.

As you play, you can clearly see how the template has 
each of the four parts of a good Obby. You move around 
and jump to complete it, there are obstacles to avoid, check-
points mark the way, and there is an end goal to complete 
the level. But obviously, it’s not a very fun game right now. 

START
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�STEP 3. EDIT THE TEMPLATE
Remember how we talked about making your game 

stand out from everyone else’s? A lot of people have prob-
ably used this template to make a game, and the first thing 
someone is going to notice is the big, bright blue sky. Let’s 
start by changing that.

In the View menu, in the Show section, make sure the 
Explorer box is selected. If it is, you should see the Explor-
er panel to the side, probably on the right. Look for the 
listing labeled Lighting and click it. You should see a list of 
Properties pop up below this panel.

Properties-Lighting “Lighting”

Appearance

Ambient

Brightness

ColorShift_Bottom

ColorShift_Top

GlobalShadows

OutdoorAmbient

Outlines

Data

ClassName

GeographicalLattitude

Name

Parent

TimeOfDay

Lighting

1

41.733

Lighting

Place5

14:00:00

Behavior

Filter Properties (Ctrl+Shift+P)

Archivable

[0,0,0]

[0,0,0]

[0,0,0]

[127,127,127]

Properties-Lighting “Lighting”

Appearance

Ambient

Brightness

ColorShift_Bottom

ColorShift_Top

GlobalShadows

OutdoorAmbient

Outlines

Data

ClassName

GeographicalLattitude

Name

Parent

TimeOfDay

Lighting

1

41.733

Lighting

Place5

14:00:00

Behavior

Filter Properties (Ctrl+Shift+P)

Archivable

[0,0,0]

[0,0,0]

[0,0,0]

[127,127,127]

�Roblox Corporation

LIGHTING PROPERTIES SECTION.

�The list of properties 
is really long and there is 
a different list like this one 
for each of the things in 
the Explorer list. There are 
a lot of numbers and words 
to figure out, so instead of 
getting overwhelmed, just 
look at the Data section. At 
the bottom of this section 
is a TimeOfDay value. The 

default time of day for the template is 14:00:00 (that’s mil-
itary time, which uses a 24-hour clock). The time 14:00 is 
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the same as 2:00 p.m. in the afternoon. Because the game 
template is set to take place in the early afternoon, the sky 
is bright and blue. To make it feel a little different in your 
game, let’s change that to nighttime. Simply click 14:00:00, 
type in a new value, say 20:00:00 (which is the same as 8:00 
p.m. in the evening), then press Enter or Return. Now your 
sky should have a nice purple and black night sky effect.

�Roblox Corporation

�THE OBBY TEMPLATE WITH A NIGHT SKY BACKGROUND.

�See how easy that change was and how big of a difference 
it made? While we’re on the topic of visual changes, let’s make 
a few more changes inspired by the way we edited the sol-
dier back in Chapter 3. Right now in this template, the blocks 
that you’re supposed to walk on are white and the blocks 
you need to avoid are red. Let’s change the good blocks to 
normal-looking red bricks instead, and change the bad blocks 
to neon red so they stand out even more in the nighttime.
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Start by zooming the camera out so you can see most 
of the level all at once. Click with the left mouse button and 
drag it to make a box that selects multiple white blocks at 
once. Now you can make changes to them all instead of 
just one by one. (You can also hold the Ctrl button on the 
keyboard then click the blocks individually to select them 
all in the same group before making changes.)

In the Home menu, find the Edit section. Click Material 
and select Brick. Then click Color and select a new color—
try Crimson, Maroon, or another dark shade of red that 
looks like the color of a real brick. Now select and apply 
this material and color to all of your safe blocks. You can 
also change the Start block too. I picked Neon as the ma-
terial and New Yeller as a shade of yellow for the color.

�Roblox Corporation

�THE OBBY TEMPLATE WITH BRICK BLOCKS.

START
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�Hmm. It looks like changing the safe blocks to brick red 
isn’t really working well. The bad bright-red blocks look a 
little too similar to the good brick-red ones now, and the 
purple bouncing blocks are too dark to stand out. So let’s 
change all of those too.

After selecting all of the bad blocks, choose Neon for 
the material and Really Red for the color to make sure they 
are easy to see. For the bouncing purple blocks, pick Blue 
to change it up a little bit. Now you can see how the colors 
stand out more. This world already feels a lot different than 
the template!

�Roblox Corporation

�THE OBBY TEMPLATE WITH NEW COLORS.

�Not bad for just changing some colors around.
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�STEP 4. CHANGE THE OBSTACLES
Your level looks different with a changed background and 

updated blocks, but it’s really still the same level. If someone 
has played the template before, they already know what to 
do. You’ve got to actually make it different, and you can do 
that by adding and building your own stuff into the game.

Start simple and work your way up. Select one of the safe 
bricks and click Copy. Now go to the end of the template 
level and click Paste. The new block will appear. Move it 
around as you see fit. Add more blocks to extend the level. 
Use different types of blocks too. Keep building. This is how 
you build off the template and make the level your very own.

�Roblox Corporation

�THE OBBY TEMPLATE WITH NEW PLATFORMS ADDED.

�In this image, you can see an example of some ways to 
expand on the level. I placed a few bricks floating out in 
front of the checkpoint and included one difficult spot that 
has two bad neon red blocks right next to it. After that are 
bouncing trampoline blocks the player has to use in order 
to reach the next checkpoint.
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By placing these new blocks, I’ve continued the ideas 
the template used, but also introduced some of my own: 
bouncing between multiple trampoline blocks. That wasn’t 
in the template before. Now using that foundation, you 
could make an even more complex Obby that’s full of com-
plex and exciting things for players to complete.

�STEP 5. PLAYTEST!
When you’re making a game, especially one that can be 

as tricky as an Obby, it’s important to constantly play your 
own game over and over to make sure it isn’t too hard. You 
should also ask friends and family to try it out too. This 
is known as playtesting, and all game makers across the 
world do it to make sure their games are fun for everyone!

As you playtest, you might find things you want to ad-
just, add, or delete. When you do, go ahead and make 
those changes, then playtest again. 

*  *  * 

Look at that—you’ve officially made your first game in 
Roblox! Congratulations. Now we’re going to take things 
to the next level and learn about world building. Floating 
obstacle courses are fun, but making actual worlds to ex-
plore is even better.
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�Your first game is probably pretty simple, 
and that’s okay. You had to learn to crawl 
before you could walk, and making games 

in Roblox is no different. In this chapter, we’re 
going to learn about building worlds and why a 
world is so important for game creation. You’ll 
also figure out how to:

•	 �Design worlds that look realistic 
•	 �Decide how large or small to make a 

game or level within Roblox
•	 �Speed up game creation by reusing 

objects and environments without having 
it feel too repetitive

•	 �Create different styles of worlds for 
different genres of games
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�WHAT WILL YOUR WORLD LOOK LIKE?

�One of the first and most important steps to take when 
brainstorming your game idea is to think about how it fits 
into a bigger world. By “world” I don’t just mean the Earth 
that we live on, but “world” in the sense of a whole set-
ting. For example, Star Wars, Harry Potter, and Pokémon 
are all different “worlds” that you probably know some-
thing about. The creators of those things did a ton of world 
building to help them come to life. They made up different 
locations in their universe, a bunch of characters and their 
families, and backstories that are fun to learn about. 

Your simple Roblox game probably isn’t going to be-
come the next Harry Potter or anything like that, but if you 
want it to be as good as it can be, then you should try to 
make a really cool world. 

�DESIGNING A WORLD
Whether you think you might make one giant game in Ro-

blox or a group of smaller ones, you should consider how ev-
erything ties together. The most important part of building a 
world as a game creator is to approach it like you would if you 
were a player. Does your world have an overall theme, like a 
medieval kingdom or a planet in outer space? What would you 
think was fun and interesting? What would make you want to 
keep playing? It can be hard to remember all of the details 
you’re thinking up in your head, so you might want to write it all 
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down. You can even draw out what parts of your world might 
look like on paper. 

�First Impressions
�Spend some time imagining exactly what your players will 
see first when they start a game. Those first moments can 
shape how they view your entire game.

When you’re coming up with the world that your game 
takes place in, think about: 

•	 �What kind of planet is this on? What is the terrain like?
•	 �What are the people like who live there? 
•	 �What do they do all day?

When you make a really well-thought-out world, you can 
even make different types of games about that one world. 
For example, you could set a racing game, an Obby (an 
obstacle course game with platforms and traps to avoid), 
and an action game all in that same world. 

�WORLD SIZE
You can imagine your world size in two different ways:

1.	 You can get one small idea and build something big-
ger from it.
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2.	 You can think of a big world right from the begin-
ning and then fill in the details as you go.

The best part of all this is that there’s no right or wrong 
way to make your world—it’s yours, after all!

�REUSING MATERIALS TO MAKE THINGS EASIER
One of the most important things you can do as a game 

designer is to find ways to make your life easier. For example:

•	 �Don’t redo work that doesn’t need to be done 
again—use Copy and Paste whenever you can! 

•	 �Try to avoid wasting time on unimportant things, like 
stressing out about what color something should be, 
before you even have it working inside the game.

For example, if you spent all afternoon making a brand-
new house model for a city in a game you’re making, don’t 
start from scratch when you make the next house mod-
el. Take the existing house and adjust the layout, colors, 
and material to make it fresh and unique without having to 
spend too much time.

You can find more tricks and tips to customize your 
game fully without bending over backward in Chapter 13.
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�MAKING YOUR IMAGINARY WORLD 
INTO A ROBLOX WORLD

�Now it’s time to put all of your brilliant ideas into your com-
puter. Open up Roblox Studio and let’s get started.

When you first open up Roblox Studio, in the center of 
the screen there is a large space full of options for differ-
ent types of starting templates. To build your world from 
scratch, it’s usually best to pick either the Baseplate tem-
plate or the Flat Terrain template. 

�GAMES VS. PLACES
When you’re first starting out the Game Templates are 

a great starting point. An important thing to know: when 
you’re working on a game, the area you’ve built and creat-
ed objects in is known as a place. Not all places in Roblox 
are technically games, but all games did first start out as 
a place. When you’re in Roblox Studio, if you click the My 
Projects option below New Project and My Games then 
you’ll see something that has your username in it as your 
own personal place. You can build your own house, make 
a city, or do whatever you want to create your own little 
world within Roblox that people can visit. 
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�Roblox Corporation

�A BLANK CANVAS OF FLAT TERRAIN IN ROBLOX STUDIO.

�Now, let’s get started creating something. In this im-
age, you can see what an empty Flat Terrain looks like. At 
the top of the screen you’ll see a list of options with dif-
ferent tabs and columns. Since this Flat Terrain is looking 
super boring, start by adding some interesting land forma-
tions. Click the Terrain menu to get a bunch of options like 
Generate, Add, Subtract, etc. This is where you’ll spend 
most of your time when you start making Roblox worlds. 
Go ahead and adjust your terrain so it matches your ideas.

�FILLING YOUR WORLD
Think back to your overall theme idea, if you had one. 

I personally like fantasy kingdoms, so I’ll use that as an 
example. After making a unique terrain with some hills, 
mountains, and a river, I am ready to place a castle and 
start building a small kingdom. After going to the Home 
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menu and clicking Toolbox, I can search for a castle and 
pick whichever one matches the theme I want to show. 
Placing it near water is good because that allows me to set 
up a bridge that will keep the castle out of harm’s way. 

�Roblox Corporation

�AN EXAMPLE OF A QUICK KINGDOM MADE IN ROBLOX STUDIO.

�Adding other touches like putting gargoyle statues 
near the entrance, a statue of a hero on a hill in front of the 
castle, and other small touches will make the scene a lot 
more interesting. Now instead of just being a castle that 
was plopped into Roblox, it looks and feels like it is part of 
a much larger world. That’s the power of world building. 
Pay attention to the small details because they are real-
ly important even for a tiny game that may not otherwise 
have a deep, detailed backstory.
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Some simple ways to keep expanding on something 
like this could be:

•	 �Carving out a cave in one of the mountains and plac-
ing a treasure there for an adventurer to find

•	 �Adding quests and non-player characters (NPCs) to 
this kingdom (which we cover in later chapters of this 
book)

•	 �Building some houses to make a small village around 
the castle 

Before you know it, your world will quickly start to come 
alive!

*  *  * 

�Now that you’ve started building a world of your own, 
it’s important to consider what you’re going to put in that 
world to start filling it up. Next we’ll dive into the specif-
ics of making your own models and customizing existing 
stuff from the Toolbox.
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�Does your head hurt from trying to bring your 
imaginary world to life inside Roblox? If not, 
you must be superhuman! Figuring out how 

to pour those amazing ideas from your brain into 
a digital format like Roblox is not easy. It takes 
a lot of creativity, hard work, and determination 
to craft something full of enough energy to keep 
players interested.

�No matter how interesting your world is, it 
won’t be that much fun unless there’s something 
to interact with, like people to talk to, enemies to 
fight, or obstacles to avoid. This is where Roblox 
objects come into play. Some of the things you’ll 
learn in this chapter include how to:

•	 �Customize objects already in the Toolbox
•	 �Know the different types of objects in 

Roblox
•	 �Understand what objects are made out of
•	 �Save and use your own custom objects



118  THE ULTIMATE ROBLOX BOOK: AN UNOFFICIAL GUIDE

�WHY THE ROBLOX STUDIO TOOLBOX 
IS SO GREAT

�Roblox Studio has a lot of buttons and menus. Just focus-
ing on the Toolbox is a great way to keep things simple at 
first.

�Roblox Corporation

�CHECKING OUT A CAR FROM THE ROBLOX STUDIO TOOLBOX.

�The Toolbox is full of templates, or premade things, 
that you’re free to use in your games. Maybe you want to:

•	 �Make a game where you drive around a city? Then 
go ahead and type car into the search bar of the 
Toolbox and see what pops up. 

•	 �Make an Obby and want a big dragon to be sitting 
on a ledge nearby for a cool effect? Go find one!

•	 �Build a massive city for players to explore and want 
a bunch of big skyscrapers? Try typing things like 
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office building or even skyscraper into the search 
bar of the Toolbox to find some.

The best thing about the Toolbox is that you don’t need 
to use what you see pictured exactly as it looks there. Once 
you place an object into your game, you can customize and 
change it as much as you want—the color, the material, 
and so on. In fact, you’ll want to change those things if you 
plan on publishing your game to the Roblox site. If it only 
uses Toolbox template objects, people will be less likely to 
recommend your game since it will seem like you didn’t put 
much work into making it feel unique.

�DIFFERENT TYPES OF OBJECTS

�Roblox offers loads of objects you can use. For example:

•	 �Animals, including dragons, bears, kangaroos, and 
snakes

•	 �Vehicles, like cars, trucks, planes, and helicopters
•	 �Military-themed items, such as bunkers, soldiers, 

and tanks
•	 �Fantasy-themed things, like knights, castles, and wizards
•	 �Spooky stuff, like ghosts, zombies, and monsters
•	 �Buildings for making a city, such as houses, schools, 

and banks
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•	 �Things to design the inside of a building, like furni-
ture, TVs, and appliances

•	 �Weapons for fighting, like swords, guns, and rocket 
launchers

•	 �Totally random stuff, like clowns, fidget spinners, 
and paintings

The term objects can refer to a wide range of things in-
side Roblox Studio, but in this chapter we’re talking about 
things that you’d make in the game using blocks and parts.

�WHAT ARE OBJECTS MADE OF?
All of the models in Roblox are built using the same 

handful of standard parts like the Block, Cylinder, Sphere, 
and Wedge. You just have to get creative with how you 
reshape, resize, and adjust each of the shapes to fit 
together in special ways. You’d never guess that houses, 
cars, and horses were all made in Roblox using the same 
standard parts.

�HOW TO CREATE YOUR OWN OBJECTS

�When you’re building your world in Roblox, sometimes you 
won’t be able to find exactly what you’re looking for in the 
Toolbox. When that happens, you’ll want to make some-
thing from scratch. 
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�Models
�I’ve been referring to things as “objects” inside Roblox 
Studio, but you’ll notice the Toolbox calls some things 
Models. Models are like collections of pieces that are 
grouped together and posted on Roblox for people to 
download. So, while a car, a house, or a soldier from the 
Toolbox is classified as a Model, it’s also an object. For 
example, a single brick is an object, and a bunch of bricks 
you’re using to make something bigger is also an object. 
But then once you finish it and upload it to the Toolbox 
(or download a finished object from the Toolbox to your 
project) it’s considered a Model.

Let’s say you’re building a normal, everyday town with 
houses, roads, cars, and everything else you’d expect to 
find in a town. Inside those houses you need furniture, 
right? Stuff like couches, tables, chairs, and other things 
that you’d find inside of a house. For this example, let’s 
pretend there aren’t any plain wooden tables to pick from 
in the Toolbox (even though there are, just pretend there 
aren’t so that you can learn how to make a model).

�MAKING A SIMPLE TABLE
When making a table, I like to start by placing the legs first. 

�Start with a Single Block
Go to the Model menu at the top of Roblox Studio, lo-

cate the Parts section, and click the Part button to view the 
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drop-down menu. Select Block. When you do that, you’ll 
get something that looks kind of like a big Lego brick on 
the floor.

�Roblox Corporation

�THE STARTING POINT OF EVERY OBJECT IN ROBLOX.

�There are a lot of changes you need to make now. It’s 
not the right shape or size, it’s not the right color, it’s not 
the right material. This looks nothing like the leg of a table 
you’d see in a house! First let’s change the color and mate-
rial since that’s the easiest change.

�Change the Material and Color
Click the block and go up to the top of the Model menu 

again. Locate the Parts section. Click the drop-down arrow 
under Material and select Wood. This will change the de-
sign of the block. 

Then click the drop-down arrow under Color and choose 
a nice dark shade of brown. For this example I picked Rust.
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�Change the Surface
There’s still a big problem though: the top of the block 

still has circles on it like a Lego brick. To change this, go 
to the Model menu and locate the Parts section. Click the 
drop-down arrow under Surface and pick Smooth. Then 
click the top of the block to change the design of that sur-
face. Now it should be like a big, wooden rectangle.

�Roblox Corporation

�A STARTING BLOCK THAT’S BEEN EDITED TO LOOK LIKE WOOD.

�The basics are done. So now we should adjust this block 
so it starts to look like the leg of a table. 

�Change the Height
Go to the Model menu and locate the Tools section in 

the top left corner of Roblox Studio. Click the Scale button 
and then click the block. You should see a bunch of floating 
circles colored green, blue, and red. Each of these circles 
represents a different direction that you can drag to change 
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the shape of the block. Start by picking the green one float-
ing above the block and drag it up to make the block one 
unit taller. That’s about the same height as an average table.

�Change the Width
Now pick a red circle and drag it toward the other red 

circle to make the block thinner, like a table leg, and then 
do the same thing with a blue circle. It should be a rela-
tively tall, but still sort of thick, rectangular block now. But 
most table legs I’ve seen are a lot thinner than this, so let’s 
take it a step further.

Click the block and go to the right side of the screen. 
You should see two panels. The lower panel should be la-
beled Properties - Part. Scroll down until you see the word 
Part in bold. Make sure the arrow to the left of Part is point-
ed down, so that the subsection is expanded. Click the 
arrow beside the Size section to expand the subsection. 
You should see a list that includes X, Y, and Z. If you’ve 
ever worked with graphs in math class, that’s what this is 
like. Think of those numbers as the axis on a graph and the 
block you’re making as the graph itself.

The X number controls the distance between the red 
circles, the Y number controls the distance between the 
green circles, and the Z number controls the distance be-
tween the blue circles. Since the height Y is already good 
(the number should be 2), you don’t want to change it; 
leave the Y number alone. But you should change the X 
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and Z numbers. Click the X number, enter 0.5, and then 
press Enter or Return on your keyboard. Repeat this for the 
Z number. The block will now be thinner like a table leg 
would be. 

�Roblox Corporation

�A TALL, SKINNY TABLE LEG MADE IN ROBLOX STUDIO.

�Copy That Leg Three Times
Since making that leg just right took a while, and we 

need three more legs, let’s not go through that whole pro-
cess again. Instead, let’s just copy and paste the leg. Click 
the Home tab and then locate the Clipboard section in the 
top left corner of Roblox Studio. Click the table leg and 
then click the Copy option. (You could press the Ctrl + 
C keys on the keyboard as a shortcut on a PC.) Now click 
Paste three times to create three legs in a row. To arrange 
the legs, click and drag each leg to an appropriate spot on 
the floor. Space them far enough apart so that it looks like 
a tabletop could sit on top of them.
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�Roblox Corporation

�FOUR TABLE LEGS READY FOR THE TOP OF THE TABLE.

�Add the Top of the Table
We’re almost done! Now we just need to make the top 

of the table. 
Paste one more leg, but this time place it on top of one 

of the table legs. It doesn’t matter which one, but I’ll be 
using the bottom left leg.

Now we want to change this block’s Y number to 0.5 be-
cause we want it to be thin like the top of a table. You can 
adjust its location slightly if you need to make it align to 
the leg correctly. Click the Model tab and locate the Snap 
to Grid section. Uncheck the box that says Move. Now you 
can freely move the object around to get it just right. When 
you’re done, check the Move box again.

After you get it lined up, extend the blue and red cir-
cles across so that the tabletop meets the other legs. You 
should now have yourself a nice looking table to use in a 
modern house setting! 
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�Add a Detail
You can grab a vase with flowers from the Toolbox and 

place it on top.

�Roblox Corporation

�A COMPLETED KITCHEN TABLE IN ROBLOX STUDIO.

�Just like anything else, it takes a lot of time and practice 
to get good at making objects in Roblox! The more you 
practice, the easier and faster you’ll be able to do it.

�HOW TO UPLOAD YOUR MODEL TO 
ROBLOX IN THREE EASY STEPS

�Your table is done! It looks great, but it only exists inside 
this specific game you’re building right now. You wouldn’t 
want to have to rebuild this table (or any other model you 
make) every time you want to use it, would you? That’s why 
you need to save it and put it on the Roblox site.
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�STEP 1: GROUP EVERYTHING
You first want to make sure you select each and every 

part of your object. Start by selecting all of the individual 
pieces of your table such as each leg, the top of the table, 
and the flower vase all together. Once everything is select-
ed, click the Home tab and then locate the Edit section. 
Select Group and all of the pieces will connect together. 
Now when you move it or use it again, everything will look 
exactly like this from the start.

�Roblox Corporation

�THE TABLE IS SELECTED IN THE ROBLOX 
STUDIO.

�STEP 2: NAME IT
To save the table for good on Roblox (after grouping 

the pieces), first click on the table to select it. Then lo-
cate the Explorer panel on the right side of Roblox Studio. 
In the Explorer panel, locate the icon that says Model—it 
should be in a blue bar. Click that blue bar and rename it to 
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whatever you want. I’m going to name mine Dining Table 
with Flowers for accuracy, as shown in the image. 

�STEP 3: SAVE!
Now right-click on the new name and select Save to 

Roblox. This will permanently save your table as part of the 
Roblox system! (If you don’t want to make it public, select 
Save to File instead.)

Follow the prompts. If you see the Create New icon 
(a pair of crossed wrenches), click it. You’ll then see a Ba-
sic Settings window where you can put in details like the 
Name, Description, and what type of Genre it is. As you 
can see, I picked Building for the Genre since I’d probably 
use this table when making a building in Roblox Studio. 

Click Finish and your table will upload to the Roblox system 
for you, your friends, and even total strangers to find and use.

�Roblox Corporation

�THE WINDOW USED TO SAVE A MODEL IN ROBLOX STUDIO.



130  THE ULTIMATE ROBLOX BOOK: AN UNOFFICIAL GUIDE

�MAKING MORE OBJECTS FOR PRACTICE

�You can make all sorts of things in Roblox using this basic 
process. You can also: 

•	 �Place the parts of an object
•	 �Change the material and color of an object
•	 �Adjust the size of an object
•	 �Assemble the parts of an object

Next time you want to create an object, try playing 
around with the Sphere, Wedge, or Cylinder shapes in-
stead of a Block. Making models really well will make your 
games extra unique, so be sure to practice them!

�HOW TO CREATE CHAIRS
To get more practice, let’s make some chairs for the table. 

�Grab a Part to Start With
Since we already have something that’s the material and 

color we want it, let’s copy it. Start by selecting the table. 
Click the Home tab and locate the Edit section. Click the 
Ungroup option. The pieces of the table are now separat-
ed, and you can pick individual pieces of the table.

Select one of the legs, copy it, and then paste it. Now 
just move it off to the side wherever you want your first 
chair to be. 
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�Change the Size
Click the chair leg you just created. Then go to the 

Properties - Part panel on the right side of Roblox Studio 
and find the Size section again. Make the X and Z values 
even smaller than they are now. Something like 0.25 should 
be thin enough for the legs of a chair. While you’re there, 
change the Y to 1 so that it’s short enough to actually fit 
under the table.

Copy and paste the leg you’ve made so there are four 
arranged in a square pattern, just like an actual chair that is 
used at a dining room table. 

�Make the Seat
Now take the top of the table, copy it, and place it on 

top of the four chair legs. Adjust the X, Y, and Z numbers 
until you’ve created a seat that looks to be the right size. 
Then move the seat until it’s sitting perfectly on each of 
the four legs. 

�Make the Back
Now, for the final touch, the back. Duplicate the seat of 

the chair, resize it, and position it so that instead of being 
flat on top of the legs, it becomes the straight back of the 
chair itself. 

You could also add another flat layer on top of the seat 
and give it a dark blue color with a fabric material. It will 
look like a seat cushion! You can duplicate this finished 
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chair to make as many as you like. I decided to make six 
chairs and arrange them around the table.

�Roblox Corporation

�A TABLE WITH WOODEN CHAIRS THAT ARE USED IN A HOUSE.

*  *  * 

�Now you know how to make your own models in Roblox. 
You could easily spend hours, days, or even weeks build-
ing cool things and uploading them to Roblox for you and 
others to use. 
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�Now that you understand world building and 
creating objects for a game, you can move 
on to more advanced parts of making games 

in Roblox. This will help you take your game from 
something really simple to something extra fun. 
In this chapter you will learn how to:

•	 �Create a Roblox world full of interesting 
objects you make from scratch, including 
cars and floating islands in the sky

•	 �Expand on the concept of the first game 
you made (see Chapter 4)

•	 �Make a brand-new second game that 
takes into consideration the information 
you’ve learned so far
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�UNDERSTANDING MORE ADVANCED 
BUILDING IDEAS

�Think of everything in this book up to this point like you 
were a video game character completing a checklist of 
quests. Now you’re strong enough and have enough points 
to finally head out on your own epic adventure. 

You could use Roblox like a digital Lego simulator, mak-
ing objects all the time, but you’d be missing out on a lot 
of its features. Now it’s time to really push the platform to 
do some awesome stuff!

�MAKE A WORLD FROM SCRATCH

�In previous chapters we mostly worked with the templates 
available in Roblox Studio, but anyone who’s spent a lot of 
time on Roblox will immediately recognize the template 
you used—and we certainly don’t want that. We want your 
game to be your own. This time, let’s make something to-
tally unique and from scratch.

For the sake of this example, let’s think of something re-
ally cool and different that you won’t find anywhere else. 
How about a world that’s full of floating islands that are high 
up in the sky above a lake of lava? Let’s give that a shot.
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�MAKING A LAKE OF LAVA
Since you’re starting from scratch, open up Roblox Studio 

and from the Game Templates panel pick Flat Terrain. This 
starting point will give you a big green field to work with. 

Now click the Terrain tab at the top and select Gen-
erate. This will open up a new menu with a bunch of 
options to pick from. Choose the landforms you want 
(such as Mountains, Hills, Canyons, etc.) and then click 
Generate.

Now that we have a starting world we can start custom-
izing it. You could have just had it all be covered in lava, but 
that would have looked a little strange. Instead, try carving 
out a big area in the middle of the land mass where a big 
lake will go. Now you just need to fill it with lava!

�Roblox Corporation

�A TERRIFYING LAKE OF LAVA!
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�To create a lava lake, you might think you should click 
Add in the Terrain section, but in this case you actually 
don’t want to do that. If you were to pick Add and se-
lect the Cracked Lava material, then you would create big 
blobs of lava. It looks really weird. The Add feature is ac-
tually better for making mountains and hills, and it is not 
very good for making lava lakes or other things that should 
stay flat. 

Instead, you should use the Paint feature in the Terrain 
section. Instead of making big blobs, Paint just covers the 
terrain that is already there (like a flat surface, for example) 
and makes it look like lava. It’s just like using a paintbrush 
on a surface in real life.

Make the lava lake as big as you’d like (similar to the 
image of what I made, for example) and surround it with 
whatever other land features you can think of. Making the 
lava appear to be in the middle of a mountain crater, sort 
of like a volcano, would be a good idea.

�ADD FLOATING ISLANDS IN THE SKY
Now that you have the lake of lava, it’s time to create 

some cool floating islands up in the sky above it. This will 
make for a really interesting landscape unlike anything else 
most Roblox players have seen before. Luckily, it’s not very 
hard to do in Roblox Studio!

There are two ways you can go about making a floating 
island in Roblox:
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1.	 Make a large mountain that extends upward from 
the flat terrain, and then cut it off to make it float. 

2.	 Have the island come from the side of the world un-
til it’s hovering over the lava. 

Unfortunately, there isn’t just a “make floating island” 
button because that’s not something people do much!

�Extend a Mountain Upward
For the first option, building a mountain up off the 

ground, it is as simple as: 

•	 �Clicking the Add feature on the Terrain section
•	 �Picking a Material type
•	 �Clicking the left mouse button on the ground
•	 �Dragging upward until you’ve created a pillar of 

terrain to the sky

From here, just add more Material onto it from the sides un-
til it looks like an island (which is still connected to the ground).

�Go back to the Terrain section again and pick the Sub-
tract feature to get rid of the bits connecting the island to 
the ground. It can be tough to totally eliminate things this 
way, so I also recommend using the Smooth feature to get 
rid of any pointy edges on the terrain. Making it look pol-
ished and natural is important so your players don’t end up 
thinking you rushed through it!
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�Roblox Corporation

�THIS IS A WORK IN PROGRESS OF MAKING A FLOATING ISLAND.

�Add Blocks of Terrain 
Your second option is to select the Add feature in the 

Terrain section and actually point the selection tool up at 
the sky in Roblox Studio. You’ll notice that Roblox doesn’t 
just let you pick something floating over the middle of the 
world (because of the grid), but you can add terrain up 
against the invisible wall at the edge of the world. Just do 
that and extend the terrain over the lake of lava. 

�From there, subtract the bits connecting it from the side 
and you’ll eventually have a floating island! Smooth out the 
edges to make it look even better.
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�Roblox Corporation

�ANOTHER WORK-IN-PROGRESS FLOATING ISLAND.

�Finished Product
Regardless of which option you pick, the end result will 

be a floating island over a lake of lava.

�Roblox Corporation

�YOU NOW HAVE COMPLETED FLOATING ISLANDS OVER A LAVA LAKE!
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�PUTTING THE WORLD TOGETHER
Now you have an awesome floating island that’s hover-

ing over a terrifying lake of lava. There are so many possi-
bilities for this game already! If you want to keep working 
on this idea, try the following:

�Make More Islands
Why would a world like this only have one floating 

island? You could make more islands that are all different!

�Put Floating Obby Courses Between the Islands 
Having more than one island is great, but you need to 

give players a way to travel between the islands, right? One 
of the most fun ways to do that is to create short Obby cours-
es as a way to travel between them (sort of like the floating 
Obby that you made as your first game back in Chapter 4!).

�Give Each Island a Story
Put characters who have unique stories to tell on each 

island to make these places come alive. Maybe you could 
have the player complete a short quest on each island be-
fore they can go to the next island.

�Don’t Forget to Make the Lava Hurt the Player
Just because the lake looks like lava doesn’t mean Ro-

blox Studio knows it is supposed to hurt the player. If the 
player falls off of an island, you’ll want to make sure the 
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lava actually hurts them. We’ll cover some ways to do that 
in the next few chapters about scripting.

�CREATING ADVANCED MODELS

�I bet you’re ready to take on something a little more complex. 
Sure, making basic things like a table and chair is fine, and 
building really cool floating islands is great and all. But it’s 
only the beginning. Let’s get into some more advanced stuff.

How does making your first fully operational car in Ro-
blox Studio sound? Cars are a bit more complicated be-
cause you need to add axles to the wheels so that they can 
spin, and add a seat for the player to sit on. After that, you 
can even make a racing game as your second project in 
Roblox. That’s a big step up from a short Obby!

�MAKING YOUR OWN CAR
To get started making your own car, you are going to 

begin with the most basic version possible. This is going to 
look just like a car made with Legos and that’s okay! Since 
it’s your first one, you just need to learn how to do it. You 
can make it look nice later.

�Start with a Brick
First, choose a template. For this example, I picked the 

Racing template. Click the Model tab and locate the Parts 
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section. Click the drop-down menu below the Part button 
to view the drop-down menu. Select Block. A Lego brick–
like block will appear on the terrain surface.

�Enlarge It
Once you have that placed, in the Model tab locate the 

Tools section and pick the Scale option. Use the blue and 
red circles to stretch out the brick so it’s a wider and longer 
rectangle. Make it a little taller too by dragging the green 
circle so it grows upward.

�Roblox Corporation

THIS WILL EVENTUALLY BE A VERY UGLY CAR.

�Create a Wheel
Now that you have the base of your car, it’s time to add 

some wheels! There isn’t a wheel shape under Part, so this is 
where you need to get a little creative. If you think about it, 
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aren’t wheels basically skinny cylinders? If you had a cylinder 
and cut it into slices, each slice would be a wheel shape. 

So grab a cylinder from the drop-down menu under 
Part. Then select Scale and drag the red circle inward to 
make it thinner, and move the green circle out to make it 
taller. Keep tweaking both of those until it looks like the 
kind of wheel you want. You’ll want big wheels so it can 
keep the car flat on the surface for driving with good trac-
tion. Make just one wheel for now. 

�Add the Wheel to the Base
Making a wheel is great—but you’ve got to attach it to 

the car base too! Roblox makes that very easy. 
In the Model tab, locate the Parts section. Click the 

drop-down menu under Surface and select Hinge from the 
list. Click the side of the cylinder you want to face the car 
and boom! Now there’s a little hinge on the cylinder. 

In the Tools section pick the Rotate option, flip the cyl-
inder so that the hinge faces the base of the car, and then 
move it close enough to connect. You’ll see a blue box 
appear if you did it correctly.

�Copy and Paste Three More Wheels
Now you just have to duplicate the wheel. Simply copy 

and paste it three times, and then place those wheels on 
your fancy, blocky car. Once they’re all connected, don’t 
forget to move the base of the car up off of the ground a 
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little bit. If it’s touching the ground at the same time as the 
wheels, then the car won’t be able to move!

�Roblox Corporation

THIS VERY DULL CAR IS ALMOST READY TO ROLL OUT.

�Add a Seat
For the final touch, you need to add a seat for the player 

to sit in, like the black block you see in the image. Once 
again, Roblox makes this very easy to do. Click on the base 
of the car where you want the seat to be placed then click 
the Model tab at the top. On the far right locate the Ad-
vanced section. Click the circled Gear icon in the upper 
left (the icon is called Advanced Objects). An Advanced 
Objects panel will appear below the Toolbox panel. Scroll 
down the list in this panel. Near the very bottom locate the 
item called VehicleSeat. Double-click it, and you should 
see one pop up on your car.
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�Steering a Car
�Moving your car will be easy. When you’re playtesting, you 
can make the car go forward by pressing the W key, and you 
can steer it using the A and D keys.

As a player, all you have to do to get the vehicle seat 
to work is to walk toward the car until you hit up against it. 
The character will automatically jump into the seat! 

�MAKING A RACING GAME IN FIVE STEPS

�Now that you’ve learned how to do some more advanced 
things in Roblox, like make your own worlds and build cars, 
you can apply those lessons into the creation of your sec-
ond game! The first game we made back in Chapter 4 was a 
very simple Obby. All players had to do was run, jump, and 
avoid obstacles. For your second game, we’ll make some-
thing that will be designed for multiple people to play at 
once: a racing game!

�STEP 1. CHOOSE YOUR SETTING
Before you get started, think about what type of racing 

game you want to make. 

•	 �Do you want this to be a realistic racing game that 
takes place on normal roads around a city? 
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•	 �Do you want this to be a racing game on a beach or 
across floating tracks in the air? 

•	 �It could even be on the moon if you wanted. Or 
across rainbows.

Just start by picking a setting and let that place help guide 
all of your other decisions. To keep things simple, I will show 
you how to make a normal racing game around regular streets. 

�STEP 2. DECIDE HOW YOU’LL MAKE THE GAME
Roblox gives you two basic ways to go about making 

your first racing game:

1.	 Use the Racing template: This is an awesome idea 
if you’re just getting started because this template 
already has all of the pieces laid out for you. You can 
learn a lot by looking at the models, the track layout, 
and the scripts used for the game. Since you’re read-
ing this book, there’s a good chance you’re probably 
just getting started creating games in Roblox.

2.	 Build it from scratch: This is the much more diffi-
cult and longer process, but it will teach you more 
and you’ll have fun making it on your own. Once you 
understand how to make a racing game using a tem-
plate, you can try building your own racing game 
from scratch. For this tutorial, however, we’re going 
to focus on the template way to get you started.
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What do you need for a good racing game? It’s simple: 
vehicles and a track of some kind. Players need to know 
where to go and need a way to get there. That’s about it. 
The players are free to create their own rules from there 
and let the competition begin.

�STEP 3. GRAB THE RACING TEMPLATE
We’ll start with using the Racing template you can find 

in Roblox Studio. Once you open it, you’ll see that a full 
race track is already built with a lot of different road types, 
bridges, tunnels, and even a river and lake. This is a great 
starting point so that you can get some ideas and see what 
a racing game in Roblox could look like. 

Each of the cars is set up at the starting line beside player 
spawn points (where players begin the game). This way, once 
players are in the game they can pick which car they want.

�STEP 4. EDIT THE RACING TEMPLATE
Just as you’ve done before, go ahead and edit the Ro-

blox template to make it your own. Add other landforms, 
change colors, and add details.

If you select things in Roblox Studio like the road itself, 
then you can copy and paste it to create new branches 
and change the direction of the track. Using the Paint fea-
ture (look for it in the Terrain menu), you can change some 
spots from road to grass or to dirt so the track twists and 
turns in new directions.
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Just pay attention to how the template is set up and 
then make changes to customize the game how you want.

�STEP 5. ADD FEATURES TO MAKE THE GAME 
	 FAIR

One of the most important things about racing games 
to keep in mind is that, if you’re not careful, players can 
easily cheat. For example, if you don’t prevent them from 
driving off the track to take a shortcut to the next check-
point, then the track you made is useless. You can prevent 
this by putting barriers or bars along the track, something 
that this template didn’t do. Or you can have your track be 
floating in the air or surrounded by water. This way if they 
get off the track, they’ll be way behind as punishment. 

*  *  * 

�At this point, you should feel like you have a pretty 
good handle on Roblox and Roblox Studio! You’ve made 
a basic racing game, you can create entire worlds, and 
you can even make some of your own models and objects 
inside Roblox Studio. Now it’s finally time to start learning 
about scripting—that’s how you make things happen in 
your game.
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�You will probably have a lot of stuff in your 
game worlds by this point. You’ve no 
doubt messed around inside Roblox Stu-

dio enough to make big sprawling worlds with 
mountains and rivers, a city to drive around, or 
maybe a few other interesting worlds that are just 
begging to be explored. But ultimately, chanc-
es are you’re probably feeling like what you’ve 
made so far is just not that interesting in compar-
ison to the bigger and better games you’ve seen 
in Roblox before, right? How do you make other 
things move inside the game? How do you make 
the game more complex and fun? That’s where 
scripting comes into play.
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�Scripting is how you program things to hap-
pen in Roblox. If building worlds and objects is 
like playing with Legos, then scripting is making 
the Legos move and do things on their own, as if 
they’re thinking with a tiny little brain that’s set 
to do very specific things. For this chapter, we’ll 
focus on learning:

•	 �What scripting is
•	 �Scripting in Roblox vs. traditional 

computer programming
•	 �Basic scripts to use in your games
•	 �Common scripting mistakes for new 

Roblox creators
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�WHAT IS SCRIPTING, ANYWAY?

�If you think of the parts and blocks used to build things 
in Roblox as Legos, then you can think of scripting as the 
hidden instructions that tell those parts what to do when 
they come “alive” on the screen. It’s sort of like when Andy 
leaves the room in Toy Story and all the toys come to life, 
or when Doc McStuffins uses her magic stethoscope to 
make her toys come alive—except this time you get to tell 
the “toys” what to do!

If this all sounds really confusing to you so far, don’t 
worry. It will eventually make sense once you see how it 
works and start to try it for yourself. For now, just think of 
scripts in Roblox like directions. 

�Roblox Corporation

�THIS IS WHAT SCRIPTS LOOK LIKE IN ROBLOX STUDIO.
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�For example, if you wanted to make a game about driv-
ing around a city, you might want to script a way for peo-
ple to walk up and down sidewalks. The script is what tells 
them where to walk, how to walk, and so on. Scripts are 
even used for the simplest things in Roblox, such as mak-
ing words pop up on the screen.

�HOW SCRIPTING FITS INTO TRADI-
TIONAL COMPUTER PROGRAMMING

�If you want to make video games, then you can take a few 
different avenues. There are programmers, designers, artists, 
writers, producers, and a bunch of other related jobs for any 
video game company. They each do something different:

•	 �Writers are in charge of writing the stories
•	 �Artists are in charge of making the art
•	 �Programmers are in charge of making the things on 

the screen do stuff; this is basically the scripting

�PROGRAM “LANGUAGES”
If you want to be a video game programmer, you’ll want 

to pay a lot of attention in computer science and other 
technology classes to learn the basics. There are a bunch 
of different programming “languages” out there too. Just 
as people around the world speak and read in different 
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languages, programmers use different languages to make 
games. Some popular ones are:

•	 �C# (pronounced C-sharp) 
•	 �C++
•	 �Flash
•	 �Python
•	 �Java 

There are many more too. Game developers also use 
“game engines,” which are programs that streamline and 
premake a lot of the features needed to make games. Some 
of the most popular ones are: 

•	 �Unity 
•	 �GameMaker
•	 �Unreal 

Roblox actually uses a slightly customized version of Lua 
as its programming language. It’s a lot different than the 
stuff we’ve mentioned here, but there’s some similarities. 

When you’re just building stuff in Roblox Studio, like 
tables and chairs, you don’t need to know anything about 
Lua, but when it comes to doing more advanced stuff like 
running scripts, you do. That’s what this chapter and the 
next one will cover too.
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�SUCCESSFUL PROGRAMMING 
Typing out things as accurately and carefully as possible 

is super important to any type of programming. If you acci-
dentally spell something wrong, the script won’t work cor-
rectly. And just like when you write in school, you need to 
follow grammar rules. Programming languages have their 
own rules like that too.

�BASIC SCRIPTS TO USE IN YOUR GAMES

�There are a bunch of different scripts that could be useful 
in your Roblox game. To help get you started, I’ve included 
two of the most basic scripts that all Roblox users of your 
skill level should be comfortable using. 

�OBJECTS THAT HURT THE PLAYER ON CONTACT
Creating things that can harm a player has been a go-to 

strategy for game developers ever since the first computer 
game was created. As a game creator you’ll definitely need to 
know how to do this. Your game will need objects and areas 
that a player can’t touch without getting hurt. Sometimes those 
objects can even kill a player as soon as they make contact too.

For this example, let’s just make something similar to 
the Obby we saw in the example back in Chapter 4. Open 
up that starter game again, but this time we’ll start build-
ing out our own level. Place a few floating blocks in front 
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of the starting pad and then make some of them neon red. 
This way it’s clear which ones are dangerous.

Now you’ll want to right-click on each red block you made, 
select Insert Object > Script, and paste this script text:

local brick = script.Parent
brick.Touched:connect(function (object)
if object.Parent:FindFirstChild(‘Humanoid’) then
object.Parent.Humanoid:TakeDamage(100)
end
end)

It’s important that you copy and paste this exactly as it 
appears here because the line breaks separate the com-
mands in the code and make it clear which specific things 
are happening. After you finish this book and you continue 
to learn more about programming, you’ll learn that just like 
writing essays and papers in English class, good grammar 
and syntax in coding is super important as well.

This script block will make it so that if the player touches 
whatever this script is attached to (such as the red blocks), 
then the player takes a full 100 damage (that’s the max 
amount of hit points) and dies. When you die in Roblox, all 
of the parts of your character fall away like an explosion. 
It’s actually really funny!

You can adjust this script for other situations too. For 
example, maybe you want the player to only take a limited 
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amount of damage and not a full 100. If so, just change the 
number at the end of the script and you’re good to go.

�MAKING A HEALING ITEM
Now that you know how to make an object that hurts 

the player, let’s cover how to make an item that heals the 
player when touched. By combining these two elements 
together (objects that hurt and objects that heal) you could 
make a game with traps and other deadly areas, but also 
give players opportunities to heal in between difficult parts 
by finding health pickups along the way. 

For this example, let’s go back to the soldier we custom-
ized earlier in this book. You can go to the Toolbox menu in 
Roblox Studio and type health kit into the search bar. From 
that list of items, you should be able to find something that 
looks similar to what’s shown in the image. Drop the health 
kit into your game world.

�Roblox Corporation

�A SMALL HEALTH KIT.
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�In order to make this item actually heal the player, we 
need to use another script. This script will first check to see if 
the health kit is touching anyone or anything. If it is, then it will 
make sure it’s touching a human (like the player) or some oth-
er player in the game. This makes sure the health kit doesn’t 
also heal enemies. Just right-click the health kit, select Insert 
Object > Script, and enter the following script in the panel:

local healthPack = script.Parent

local function handleTouch(otherPart)
	 local character = otherPart.Parent
	 local humanoid = character:FindFirstChild(‘Humanoid’)
	 if humanoid then
		  print(‘Time for a quick heal!’)
	 end
end

healthPack.Touched:connect(handleTouch)

Great! Now if all of that checks out, then the health kit is 
ready to give the player however much health you decide. 
For this example, we’ll say 20 health points. Since I am go-
ing to keep adding on to this code, what I’ll do is bold the 
parts of the next code segment that are new to let you 
know what’s been added. All of the non-bold parts are the 
same as the previously mentioned script block.
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In order to tell the health kit to heal the player, we need 
to do a few things first: 

•	 �Set the value of the heal so that the game knows 
how much the player is to be healed

•	 �Make sure it increases the player’s health based on what 
it was at previously; if, for example, a player’s health is 
at 80 and you want the kit to heal 20 points, then the 
player’s health would be brought back up to 100

•	 �Make sure it isn’t active if it’s just been used so that 
it can’t be used over and over again

The new script looks like this:

local healthPack = script.Parent
local healAmount = 20
local cooldown = 5
local canHeal = true

local function handleTouch(otherPart)
	 local character = otherPart.Parent
	 local humanoid = character:FindFirstChild(‘Humanoid’)
	 if humanoid and canHeal then
		  canHeal = false
		  local currentHealth = humanoid.Health
		  local newHealth = currentHealth + healAmount
		  humanoid.Health = newHealth
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		  wait(cooldown)
		  canHeal = true
	 end
end

healthPack.Touched:connect(handleTouch)

That should now give you a fully functioning health pack 
that you can use in your games! 

*  *  * 

�As I’m sure you’ve guessed by now, the list of things 
you do with scripts in Roblox is never-ending. There are 
always new and interesting ways to continue expanding 
your Roblox game, and using scripts is a key way of doing 
that. In the next chapter we’re going to do even more ad-
vanced things with scripts. 
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�This is the chapter that could help you take 
your idea from “just another Roblox game” 
to something that’s as much fun to play as a 

store-bought game. The stuff you’ll learn in this 
chapter is a great start if you think you might 
want to be a video game creator! Here are some 
of the things you will learn:

•	 �The most common key terms for scripting
•	 �Examples of specific things you can do 

with scripts in your games
•	 �How to make a game that uses advanced 

scripts
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�KEY TERMS TO KNOW

�This isn’t a school textbook, but it does have some vocab-
ulary you should learn! With anything as complex as writing 
scripts, there are a lot of unusual words that you’re going 
to see in places like this book, online, and in Roblox Studio. 
Key terms include:

•	 �Bugs: These are unexpected mistakes in a game 
that shouldn’t be there. For example, if the player 
can’t pick up a weapon or if an enemy isn’t taking 
damage when the player attacks, those are called 
bugs. Usually bugs happen when there are a lot of 
scripts in your game. The more scripts you use, the 
more chances there are for scripting errors.

•	 �Code: This is the text inside your scripts. It tells the 
game what to do automatically on its own. Think of 
the scripting examples we looked at in Chapter 8: 
the health kit that improves a player’s heath and the 
blocks that hurt the player when touched.

•	 �Loop: This is when you teach the game to do the 
same exact thing, over and over, forever (as long as 
the instruction exists). It’s useful for playing music 
and repeating actions like an enemy appearing ev-
ery few seconds for the player to fight.

•	 �Output: This is a window that shows what happens 
when your scripts are running in the game. It will 
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also show bugs and text that you’re showing on-
screen. This output isn’t used for inside your game 
itself, but only in Roblox Studio. Think of it like a re-
sults window, or kind of like a transcript of what the 
game is thinking when it does what your scripts say. 
You’d use the output window to understand what’s 
happening and hopefully find bugs.

•	 �Print: When you’re scripting, the word print does 
not mean printing words on a piece of paper using a 
printer. It means words that are being displayed on 
the screen. Examples include a player’s dialog or a 
message for when a player enters a new area or wins 
the game.

•	 �Script: This is a group of code that tells something 
in Roblox Studio what to do in the game. It’s like a 
list of instructions that the computer understands.

•	 �Variable: This is simply a term that holds informa-
tion in Roblox. A variable can be a number, an ob-
ject, or even a string of information. For example, one 
variable might be “playerHealth,” which is how many 
HP (hit points) the player has in the game. Another 
variable could be something like “gunAmmo,” which 
could mean how many bullets the gun has. Using vari-
ables allows you to define things in your game.

There is a lot more to scripting in Roblox, but these 
terms are a good summary of things you’ll need to know. 
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�WHAT CAN ADVANCED SCRIPTS DO 
FOR YOU?

�Scripts in Roblox Studio can be used for all sorts of things. 
You can make a script that tells a certain block to hurt the 
player when it’s touched or heal the player when it’s picked 
up, like we did in Chapter 8, plus a ton more. 

For example, with a script you can:

•	 �Make enemies chase after a player and attack
•	 �Have a race start when the light turns green
•	 �Let you shoot a gun or swing a sword
•	 �Tell a character to walk into a restaurant and order a 

cheeseburger
•	 �Give players points for completing an action
•	 �Let players build entire cities in a game world together
•	 �Make a teddy bear laugh when the player clicks it
•	 �And so much more

�Roblox’s Power Source
�Roblox developers use the Lua 5.1 programming language to 
give users interactive and customizable content. Scripting 
in Roblox isn’t as powerful as writing code in bigger, more 
flexible game engines. You can’t make a game the same size 
as The Elder Scrolls V: Skyrim, for example. But you can 
still make something really fun for people to play!
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�MAKE AN ACTION GAME IN FIVE STEPS

�Now that you have some of the basics down for how to use 
scripts and what they can do in Roblox, it’s time to dive 
into a more complicated game idea that uses more scripts. 
This book shows you how to make three games:

1.	 The first game we did, an Obby, was just about 
jumping and avoiding obstacles. 

2.	 The second game we made was a simple racing 
game that had a bit more complexity than just mov-
ing and jumping around. 

3.	 For this game we’re going to do something a little 
more advanced. We’re going to make what can be 
referred to as a fighting game, or sometimes an ad-
venture game. Depending on the direction you take, 
games like this can fall into a lot of different catego-
ries on the Roblox site. We’ll lean more toward ac-
tion, so we can go ahead and call this an action game 
since that’s what great games are all about, action!

�STEP 1. OPEN A TEMPLATE
The best way to get started with a game like this is 

to open up Roblox Studio and pick the Combat template. 
What you’ll see here is a big giant wasteland with a gun, 
sword, and health pack in the middle. All around the out-
side are spawn points (where players start from). 
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The idea is that all the players will have to run toward 
the middle to try and grab a weapon and just fight it out. 
We can work off of this concept, or we can make a game 
that’s more about cooperating. Either way, the first steps 
are going to be the same.

�STEP 2. CUSTOMIZE THE WORLD
You’ve got the foundation in place, but the world itself 

is really empty and boring right now. Add buildings, walls, 
and other objects for players to hide behind and explore. 
You can make these models from scratch or customize ex-
isting stuff in the Toolbox like we’ve covered previously. 

You can make the level as big or as small as you want. 
To change things up even more, you can move the items 
from the middle and spread them out around the level. 
This way it’s not just a mad dash to the middle to get the 
items—players will instead have to go out and search for 
items that are hidden around the level.

�Roblox Corporation

�ADDING MORE 
EXCITEMENT 
AND VARIETY 
TO THE COMBAT 
TEMPLATE.
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�The type of level you make is totally up to you. In this 
example, I went for a military theme, adding a bunch of 
different buildings and objects all around so that there are 
more areas for players to hide and things to do. You could 
also try a space colony on the moon, an underground cav-
ern, or an ice palace full of giant snowmen—or whatever 
you think up!

�STEP 3. ADD ENEMIES AND SCRIPTS
Now that you have your world set up, you should de-

cide what you want your game to be about. Do you want: 

•	 �Players fighting each other?
•	 �Players fighting together against enemies?
•	 �Players fighting just for themselves against other 

players and enemies?
•	 �A mixture of a couple of those options?

You’ll probably want to add enemies though, so we 
should get started on that. 

A good basic enemy type you can add to the game 
is a zombie. Luckily, the Toolbox in Roblox Studio has 
you covered. Open up the Toolbox, type zombie into the 
search bar, and look for the one named Respawning Zom-
bie from user Ashourc05. Click it and it should automat-
ically appear in your game. (The label above it will say 
Drooling Zombie.) 
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�Roblox Corporation

HERE’S A SIMPLE ZOMBIE IN THE GAME. GROSS!

��The great thing about this zombie is that a lot of the 
scripting is already done for you. Now, let’s dig into the 
scripts a little bit for this zombie. Open the Explorer panel 
(click the View tab then click the Explorer button in the top 
left of Roblox Studio). To know if an object is already script-
ed, click on the object, such as the zombie in this case, and 
look at the Explorer panel on the right. In this case, look 
for the entry that says Drooling Zombie (it should be high-
lighted in a blue bar). To actually look inside this zombie, 
click the tiny arrow on the left of its name to expand its list 
of contents. 

You’ll see a bunch of stuff here, including: 

•	 �A Moan sound effect, which is appropriate for a zombie
•	 �An item called Body Colors
•	 �The various parts of the zombie itself 
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You should also see three icons that look like pieces of 
paper called Script, Respawn, and Animate. These three 
scripts are telling the zombie how to act. 

�Respawn: Make a New Zombie Show Up When 
One Dies 

Start by opening up the Respawn script. (Just double- 
click it.) You should see this code:

name=”Humanoid”
robo=script.Parent:clone()
while true do
	 wait(1)
	 if script.Parent.Humanoid.Health<1 then
		  robot=robo:clone()
		  robot.Parent=script.Parent.Parent
		  robot:makeJoints()
		  script.Parent:remove()
	 end
end

This script says that if the zombie’s health is less than 
1 (meaning that it dies), then a clone should be created. 
This script “respawns” the enemy so that they keep com-
ing after you. It’s a smart script that you can use with other 
enemies in any game you make.
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�Keep a List of Scripts 
�You’ll come across really cool scripts as you grab char-
acters and objects and create games. Try keeping a list 
of some of the coolest scripts so you can use them again in 
other games. I’d suggest saving a document on your comput-
er with a list that says the name of the Model and a summa-
ry of what it did so that you can find it again later if you 
need it. You could also copy and paste the entire script so 
you have it for sure in the future just in case the creator of 
that Model decides to take it down off the Toolbox.

�Animate: Make the Zombie Move
The Animate script makes the zombie move around. 

One easy tweak that you can make to the Animate script is 
to change how quickly the enemy moves around. Near the 
top of that script is this line:

local currentAnimSpeed = 1.0

All you have to do is change that number to make the 
zombie move around more quickly or more slowly, like 10 if 
you want him really fast or 5 to make it just a little bit quick-
er. It’s a good way of adding a little variety to enemies, 
like having some zombies only walk slowly, but then other, 
more difficult ones, could run really fast at the player.
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Now you can start adding more types of enemies as 
well. Depending on the kind of game you make, you might 
want to have skeletons that come after the players, ninjas, 
soldiers, knights, or something else completely. Experi-
ment by finding other enemies in the Toolbox, then copy-
ing and pasting the scripts from the Drooling Zombie into 
them. You can make those enemies move around and hurt 
the player, or do something else.

�Add a Bunch of Enemies
�One fun thing to try is to create as many enemies on-screen 
as possible, Like a giant zombie horde! This is a fun challenge 
for players to try and overcome. It’s definitely a lot more 
interesting than an empty field. 

�Script
Finally, there is one last script. Inside the Zombie object 

in the Explorer of Roblox Studio you should see a third one 
just called Script in addition to the Animate and Respawn 
sections that we already covered. This one does everything 
else for the zombie. This script tells the zombie to appear 
when placed in the game, it tells it to come after the player 
when possible, and it even tells it to make noises when it 
moves or dies. You don’t need to worry about making any 
changes here.
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�STEP 4. ADDING MORE PLAYERS
Thankfully Roblox makes it very easy to add more play-

ers to your game. Once you complete a game and publish 
it onto Roblox, it automatically supports multiple players. 
If you want to test out multiplayer features and make sure 
everything works correctly, you can: 

•	 �Go to the Test tab at the top of Roblox Studio
•	 �Select the Local Server option
•	 �Choose the number of players in the drop-down 

menu in the Clients and Servers section
•	 �Click Start 

This will simulate a multiplayer game on your computer. 
You’ll need to wait a few minutes for it to finish loading be-
cause it needs to launch multiple dummy accounts, which 
are fake accounts used to represent players. You’ll see mul-
tiple game windows pop up, so just pick one of them and 
you can test it just like you would normally using the regular 
Play button, but it’s running like it would a multiplayer game. 
We’ll cover things like Leaderboards and other features in 
Chapter 13: Finishing Your Game.

�STEP 5. FINAL TOUCHES
Depending on the type of game you want to make, the 

idea of how a player can “finish it” will vary a lot. For exam-
ple, in an Obby, finishing the game just means getting to the 



CHAPTER 9: ADVANCED SCRIPTING  177

end and that’s it. But if you create a multiplayer game with 
players fighting against each other (this is what many of the 
most popular games do), then you’ll need to track scores. In 
a lot of cases, games aren’t designed to ever “end” on Ro-
blox because developers want players to keep playing. In-
stead, they just restart and let players complete them again 
and again or fight against each other over and over.

We’ll cover how to add “kill counts” and scores to multi-
player games in Chapter 13: Finishing Your Game, and you 
can find out more about scripting repeating rounds that 
reset by studying scripts uploaded to Roblox.

*  *  * 

�This action game idea with zombies on a military base 
has the most room for experimenting and you can really 
make something cool and unique if you take the time to 
learn Roblox. For your next game ideas, try looking at 
these other Game Templates in Roblox Studio: 

•	 �Line Runner: These are games where the character 
moves across the screen automatically, and it’s up 
to you to tell them when to jump to avoid enemies 
and obstacles. These games are similar to Flappy 
Bird, Jetpack Joyride, or Super Mario Run. They 
usually take place from a side-view perspective.
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•	 �Infinite Runner: These types of games are very sim-
ilar to the games I just noted, but instead of being 
from a side-view perspective they are from the usual 
Roblox third-person view. In that way they are simi-
lar to Temple Run, Subway Surfers, and Sonic Dash.

•	 �Team/FFA Arena: Finally, you can try experiment-
ing with a Team/FFA Arena game. In the action 
game we made, we had players fighting against 
zombies, but these games put players on teams 
against each other like in Call of Duty, Overwatch, 
or Counter-Strike. If you liked making an action 
game, then this could be a much more difficult but 
rewarding next step.
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�Even the best game is a little boring without 
an interesting non-player character (other-
wise known as an NPC) in it. All of the best 

games have characters for the player to talk to 
and interact with, so your Roblox games should 
have them too.

�Could you imagine playing any of your favor-
ite games if the worlds were empty and you were 
totally alone? Sometimes that can work if the 
game is specifically designed around the idea of 
you being alone, but that’s not usually the case. 
So in this chapter we’re going to cover:

•	 �What makes an interesting NPC
•	 �Types of games that benefit from good 

NPCs
•	 �Types of games that are better without 

too many NPCs
•	 �How to actually make and program an 

NPC in Roblox
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�WHAT MAKES A COOL NPC?

�Think of some of your favorite games. Maybe it’s The Leg-
end of Zelda, or Mario, or Pokémon, or even Halo or Call of 
Duty. All of those games have interesting NPCs for the play-
er to interact with. Some games, like Mario, don’t have a ton 
of NPCs, but there are still meaningful characters with roles 
in the story. For example, they might tell Mario where Bows-
er took Princess Peach, or sell him items between levels.

NPCs can have different purposes in a game. They can 
give you information or they can help you with a quest. I’ll 
explain where to find the Purpose option in Roblox Studio 
later, but for now you should know that in Roblox the pur-
poses of an NPC can be: 

•	 �Help, which will show a question mark (?) over the 
character’s head in the game, making it clear you 
can go up and ask questions while playing. 

•	 �Quest, which will appear as an exclamation mark 
(!) over the character’s head, showing you that the 
character can give out assignments.

•	 �Shop, which will display a dollar sign ($) to let you 
know items can be purchased from the NPC.

Making an interesting NPC isn’t too hard, and you can 
go in a bunch of different directions with them. Following 
are some characteristics you might want to think about.
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�A WINNING PERSONALITY
If an NPC is funny, charming, or just nice to talk to then 

there is a much higher chance the player will remember 
and care about them.

�STRONG MOTIVATIONS
If your NPC only exists to quickly give the player an 

item or a quest, then they might end up being boring. On 
the other hand, if they have a backstory and motivations 
of their own, they are much more interesting. For exam-
ple, if the NPC character has the same enemy as you and 
wants revenge, that would give them a reason to want to 
try to help you. If the NPCs are related to another import-
ant character, then the player won’t feel like that they’re 
just talking to a bunch of random NPCs. Exploring how the 
NPC’s ideas and feelings mix with the player’s is an import-
ant part of what can make an NPC effective.

�INTERESTING VISUAL DESIGN
It’s easy to overlook at first, but if the NPCs in your game 

don’t at least look interesting in some way—either through 
the environment around them or the way that they’re 
dressed—there isn’t a very high chance the player will pay 
much attention to them. You could give the NPCs wacky 
clothes or give them a tiny house to live in, for example. 
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�WHICH GAMES BENEFIT FROM NPCS?

�Not all games need NPCs for players to see and interact 
with. Some games are actually better without other char-
acters getting in the way, while other games are improved 
dramatically if there are other characters in the world. 

�GAMES THAT ARE BETTER WITH NPCS
If you’re making a game that has players interacting 

with characters a lot, then of course it makes sense to use 
NPCs. For example, the following types of games are usu-
ally better with NPCs.

�Zombie Games 
You might be thinking to yourself, “Wait a minute, but 

players don’t really interact with zombies, they just shoot 
them!” and you’d be right. But those zombies still have to 
come after the players and attack! Because of this, you 
need to know how to program the zombies and make them 
do those things, and so a lot of the same principles of good 
NPC creation will apply. And you should have non-zombie 
characters for the player to meet and talk to as well, to 
up the stakes and make things more exciting. Just fighting 
zombies doesn’t have as much impact as trying to save 
other people too.
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�Roleplaying Games
These are the most common types of games that will 

have players interacting with NPCs. You’ll have players do 
things like:

•	 �Talk to NPCs around towns to figure out where to 
go next 

•	 �Fight alongside (or against) NPC enemies on their 
journey

Going on quests requires NPCs to give the players 
things to do and people to save. You wouldn’t be much of 
a hero if you’re not saving anyone, right?

�Adventure Games
In some ways, adventure games have a lot of similari-

ties to roleplaying games because they’re about going on 
grand journeys, fighting monsters or other bad guys, and 
saving people all across a fantastical land. But adventure 
games are different because they might feature even more 
dialog with characters and less fighting, or fewer ways to 
level up but more levels to explore.

�GAMES THAT ARE BETTER WITHOUT NPCS
Not all types of games in Roblox need NPCs. In fact, 

most of the games you play in Roblox probably don’t have 
any NPCs at all. The majority of Obbys don’t, most racing 
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games don’t, and even the shooting games and lots of other 
action games don’t either. The main reason for that is be-
cause Roblox is mostly about making games that encourage 
people to play online together. That is, Roblox is not real-
ly about making games that encourage you to interact just 
with digital characters only. 

This all goes back to the lesson of making sure you know 
who your players are and what they most enjoy doing in a 
game. If someone is playing a game like Mario Kart, then 
you can assume they want to race, not talk to characters 
about the legends and stories of the game world.

�Multiplayer Games
Multiplayer games are another example where you 

might not need any NPCs. When you’re playing a multi-
player game, you tend not to care too much about what 
NPCs have to say because your focus instead is on playing 
with or against the other human players. Why would you 
waste time clicking through dialog options with an NPC 
when you could be shooting all those other players who 
are running at you? 

�HOW TO PROGRAM NPCS IN ROBLOX

�There are a lot of different things you can do with NPCs. 
Here are two very simple examples:
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1.	 You can have NPCs come after the player and try to 
attack them, like you would have in a zombie game.

2.	 You can just have the NPCs stand somewhere and 
talk to the player when needed. 

Programming complex movement and actions for NPCs 
to do over the course of a whole game is beyond the scope 
of what this book covers, so for now let’s focus on making 
NPCs that can simply talk to the player.

�MAKING AN NPC THAT TALKS
The most basic type of NPC is the kind that just stands 

there in your game and talks to players when they walk up 
to them. These types of NPCs can be used to: 

•	 �Give players information about the game world
•	 �Give players specific missions to do
•	 �Answer questions that you think a player might have

For this example, we’re going to base everything in a 
fantasy kingdom. As a game creator, your goal is to make a 
castle guard (the NPC) talk. If a player is exploring the out-
side of a castle and sees the guard standing at a bridge, 
they’d probably want to approach that guard and ask some 
basic questions like, “What is this place?” and “Who lives 
here?” Just put yourself in the shoes of the player and fig-
ure out what they might want to know!
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�Grab a Character
To get things started, go into Roblox Studio and choose 

a template. For this example, the Castle template is a great 
choice. In the Home menu, which should already be open, 
locate the Insert section. Click Toolbox and type in knight 
into the search bar. Choose a castle guard type of charac-
ter and put him into the game world. A good location for a 
castle guard would be in front of the bridge. 

�Roblox Corporation

�A KNIGHT STANDING IN FRONT OF A CASTLE.

�Add Dialog Capability to the Character
Now that we have a cool little knight hanging out in 

front of this castle, it’s time to give him a bit more person-
ality. It’s a little boring to have him just stand there.

Start by selecting the knight and then clicking the Model 
tab at the top of Roblox Studio. On the far right of the top 
menu locate the Advanced section. Locate the icon in the 
top left corner of this section (the icon is called Advanced 
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Objects). Click that icon and a new panel will appear on the 
lower left side of the screen called Advanced Objects. This 
panel contains a list of different features. Scroll down this 
list until you see the Dialog object.

Advanced Objects

Search object (Ctrl+I)

Color3Value

ColorCorrectionEffect

CompressorSoundEffect

Configuration

CornerWedgePart

CylinderMesh

Decal

Dialog

DialogChoice

DistortionSoundEffect

EchoSoundEffect

EqualizerSoundEffect

Explosion

�Roblox Corporation

�THE DIALOG OPTION.

�Click and drag the Di-
alog object into the work-
space of Roblox Studio (the 
actual Castle template) and 
then release. Now, look in 
the Explorer panel on the 
right of the screen. (If the 
Explorer panel isn’t already 

open, then click the View tab and click the Explorer button 
located at the top left of the menu.) In the Explorer panel 
you should see Dialog listed under the Knight object in the 
Explorer menu. Click the Dialog object in the Explorer menu 
again and then drag and drop it right onto the Knight object. 
This will make the Dialog part of the knight in the game. 

�Choose Which Part of the Character Will Talk
Now you need to tell Roblox Studio which part of the 

knight is going to do the talking. Naturally, you want the 
talking bubble to appear above his head, so move the Dia-
log object onto where it says Head under the Knight object. 
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If you did it correctly, what you see on your Explorer panel 
will look like what’s in the image here. 

Explorer

Filter workspace (Ctrl+Shift+X)

Knight  

Body Colors

Hat

Health

HealthScript v3.1

Humanoid

Roblox Team

Sound

Animate

Head

LeftArm

 

Mesh

Face

HeadWeld

Dialog

�Roblox Corporation

�DIALOG IS NOW PART OF 
THE KNIGHT’S HEAD.

�For talking purposes, it al-
ways makes sense to attach 
dialog functions to the head, 
but attaching things to other 
body parts is useful in some 
instances too. For example, if 
you want a player to only be 
able to interact with some-

thing if they step on it, such as a trap, or have them hold 
an object in their hand, that’s when assigning functions to 
the other body parts would be useful.

�Make It Talk
Since we’ve got the Dialog object in the right place now, 

we can actually tell the knight what to say. Click the Dialog 
object in the Explorer panel. You should see a list of options 
appear down below in the Properties - Dialog panel. (If the 
Properties panel isn’t already open, then click the View tab 
and click the Properties button located at the top left of the 
menu.) First make sure you check the box that says InUse to 
tell Roblox Studio you want to use this dialog in the game.
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Now, decide what you want the character to say to the 
player as a greeting. Since he’s a knight standing guard 
in front of a castle, something like this might be good: 
“Greetings, citizen! How may I be of assistance?” So, let’s 
go ahead and use it. Locate the option named InitialPrompt 
and type that greeting into the empty box to the right.

A bit further down the list, locate the Purpose option. 
Since we want this guard to be seen as helpful, check to see 
that the Purpose option is set to Help. This will show a ques-
tion mark (?) over the character’s head in the game, making 
it clear you can go up and ask questions while playing. 

However, the knight character has only asked the player 
a question at this point. We haven’t given the player the 
ability to choose to ask questions to ask in return. To do that, 
right-click on the Dialog object in the Explorer panel and pick 
Insert Object > DialogChoice from the drop-down menu. A 
DialogChoice object should appear in the Explorer panel.

�Changing Your NPC’s Tone of Voice
�If you want, you can add many DialogChoice objects to expand 
the conversation even more. You can even change the tone of 
the conversation. (Go to the Dialog option in the Properties 
panel, then look for the Tone object.) Changing the Tone will 
make the visuals a little different. A Neutral tone uses the 
blue color, a Friendly tone uses the green color, and an Enemy 
tone uses red.
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The most basic question a character in this world would 
probably ask a guard like this is, “What is this place?” If you 
were walking down a path, reached a bridge across a moat 
of water, and saw a giant castle across that bridge, you’d 
probably be wondering what that is too!

Let’s add a question for the player to say. Click the Dia-
logChoice object in the Explorer panel if you haven’t already. 
Now down in the Properties - DialogChoice panel, look for 
the UserDialog object. In the empty box beside this object, 
input what you want the player to be able to say to the guard 
(in the game, it will appear as an option the player can click).
You can put “What is this place?” in that box, or you can put 
in any other question you can think of. You can word things 
however you want, but just remember that whatever you type 
here is exactly what will appear in the game.

Now let’s tell the knight what to say back if he is asked 
that question. You can come up with something unique if 
you want, but for now let’s go with, “This is Fort Blockto-
pus and it’s the capital of the Kingdom of Robloxia. This 
kingdom is ruled by King Rob Lox IV.” 

To finish up, you need to also input a few parting words. 
In both the Dialog object and the DialogChoice object look 
for the GoodbyeDialog object. The text you enter here is 
simply what a player can click to end a conversation. For 
both GoodbyeDialog objects I just put “Farewell.” If you 
did everything right, your DialogChoice object should look 
something like what appears in the image here.



CHAPTER 10: MAKING NON-PLAYER CHARACTERS  195

�
Properties- DialogChoice “DialogChoice”

Data

ClassName       DialogChoice       

GoodbyeChoiceActivate

GoodbyeDialog Farewell.

Name DialogChoice

Parent Dialog

ResponseDialog

UserDialog What is this place?

Behavior

Archivable

Filter Properties (Ctrl+Shift+P)

This is Fort Blocktopus a…

Dining Table with Flowers

Roblox Corporation

�MAKING DIALOG OPTIONS FOR 
THE KNIGHT.

�The conversation doesn’t 
have to stop there. If you 
want, you can add more Dia-
logChoice objects so that this 
NPC will be able to answer 
other questions. In this way 
you can create a complete 

conversation. For this example, the player might want to ask 
the knight what his name is, where he is from, and how the 
kingdom is doing. Then you can come up with answers the 
knight might have for all of those different questions.

�Test It Out
And there you have it! You can jump into the game now 

and test everything out. When you playtest the game, pick 
Play Here so your character drops down right in front of 
the guard. Walk up to him and click the ? above his head to 
start the conversation. Choose your dialog options. These 
are the options you put into the UserDialog lines. 
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�Roblox Corporation

�CHATTING WITH A GUARD IN A FANTASY KINGDOM.

�ADDING MORE CHARACTERS
Think of the other types of characters a player might 

come across in your game. Place more NPCs around the 
game world who can talk about random thing or offer tips 
and advice to the player. Even if your NPCs are standing 
still, they don’t have to be boring.

*  *  * 

�That’s how you make characters in Roblox for players 
to interact with. Using that knowledge, you can go out 
and fill entire cities with cool and interesting NPCs. Now 
it’s time to learn how to create exciting quests and adven-
tures while playing Roblox games!
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�Knowing the basics (and some of the more 
advanced) principles of creating games with 
Roblox means a couple of things: 

1.	 You can now expand on your imagination 
to bring some of your best ideas to life. 

2.	 You’re ready to add real game content (like 
a goal) to flesh out your world.

�One of the best ways to do that is by assigning 
players quests, or missions, with specific goals 
and rewards attached.

In this chapter you will learn:

•	 �How to develop an interesting storyline
•	 �The best ways to create quests and 

objectives in games
•	 �When not to use specific objectives in a game
•	 �How to balance content so that players 

don’t feel overwhelmed
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MAKE QUESTS FIT INTO YOUR GAME

Your players need a good reason to explore the world you 
made. What could some of those reasons be? How about:

•	 �Investigating monsters in a cave near a village
•	 �Talking to people around a town to see if they need help
•	 �Searching for a lost treasure
•	 �Reading signs to learn more about an area

�WHICH GAMES BENEFIT FROM QUESTS?

It doesn’t make sense to add quests to all types of games.

�GAMES THAT WORK WELL WITH QUESTS
Roleplaying games (RPGs) and adventure games are 

two of the best types to add quests with detailed informa-
tion about the game world and story. 

�WHEN NOT TO MAKE A QUEST
When you start playing around with the idea of mak-

ing quests in your game, it’s easy to think that everything 
in the game should be a part of a quest. You might get 
the urge to put an NPC every few feet, or in every area of 
your game, telling the players stories about the world. But 
you’ve got to resist that temptation!
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Think about all the games you’ve played. I bet that you hate 
it when characters try to talk to you too much. Players usually 
want to get into the fun of the game right away, and if you try to 
make them read too much then they might get bored and stop 
playing. Games that don’t usually have quests in them are: 

•	 �Pure action games that task players with fighting 
against one another.

•	 �An Obby, because the entire objective of the game 
is very focused and doesn’t need additional parts.

•	 �A racing game, because you’re not going to be ex-
ploring around areas other than the racing track.

�THE BEST WAYS TO MAKE QUESTS

�There are a few different ways to give a player a quest.

�SIMPLE NPC CONVERSATION
The player asks a few questions, the character answers, 

and that’s it.

�BRANCHING CONVERSATIONS
These are longer conversations that cover different top-

ics. Sometimes they might even feel like small games in 
and of themselves. Depending on what you say, you could 
even have the NPC react in multiple ways and change what 
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they’re doing. For example, if you make them upset, you 
could have the NPC walk away from the conversation. 

�SCRIPTING EVENTS
After a conversation, a character might then ask the play-

er to go do something. Until that thing is completed, the 
player can’t advance the conversation forward more. Let’s 
say the NPC wanted the player to go to a dungeon near-
by, kill a dragon, and retrieve the Holy Grail. If the player 
doesn’t do that, then they can’t move forward in the game.

�BALANCING GAME CONTENT WITH 
QUESTS

�Once you get the hang of making quests, it can be tempt-
ing to get a little quest-happy and go all-out making the 
most complex stories you can think of. But that’s probably 
a bad idea. Start out slowly by giving players smaller con-
versations and increase things from there.

*  *  * 

�You probably have plenty of ideas for how to move for-
ward with the three game concepts we’ve worked on at this 
point. You even know how to make characters who can talk 
and interact with players through conversations and quests! 
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�Most games in Roblox have multiple people 
playing together at the same time online. �

For example, if you were to play a game 
like Call of Duty with people online, you’d have 
to work as a member of a team to fight against 
the other team. You can’t just ignore the mem-
bers of your team. In this chapter, you’ll discover:

•	 �Which types of games work best for 
multiplayer

•	 �Why some games don’t really need it
•	 �How to make sure players don’t interfere 

with each other too much
•	 �What keeps users coming back to the 

game for more
•	 �Best practices for multiplayer game design
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�WHICH GAMES ARE BEST FOR 
MULTIPLE PLAYERS?

�Most of the best Roblox games embrace the multiplayer 
aspect of the platform. By design, Roblox is naturally full 
of people with similar interests and ideas, so games that 
put those people together are typically fan favorites. If you 
go back and look at the list of the best Roblox games (see 
Chapter 2) and then play them, you’ll find that they are all 
more fun if they’re played with other people.

�GAMES THAT WORK WELL WITH MULTIPLAYER
Any game that is competitive and has players trying to 

beat a high score, complete objectives quickly, or generally 
act in a way that encourages competition is going to be bet-
ter as a multiplayer game. These are good examples of games 
that almost always have multiplayer support on Roblox:

•	 �Racing games
•	 �Shooting games
•	 �Action games with lots of enemies on the screen 

Would you want to play a racing game if you couldn’t race 
against your friends? Racing against computer-controlled op-
ponents is not as fun. Plus, it’s much more difficult to program 
a bunch of opponents in Roblox Studio that know how to race 
well than it is to just let other people join the game.
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�GAMES THAT DON’T NEED MULTIPLAYER
Not every game is going to make sense for multiplayer 

to be a major focus. For example: 

•	 �If you were making a game that’s all about sneak-
ing around a house in the dark while trying to avoid 
ghosts, then playing alone might actually make it 
scarier. 

•	 �In an Obby game similar to Mario, having multiple 
players on-screen may make the game too confusing 
or difficult to navigate.

Those are just a couple of examples. 

�How to Make a Single Player Game in Roblox
�You’ve probably seen that almost all Roblox games are de-
signed with multiplayer in mind. When you play a game on Ro-
blox and someone else decides to play that same game, they 
are joining in the same world. You can’t really disable this 
feature, but if you wanted to create something that felt and 
played like a single player game, you can still do that in Ro-
blox by having players start in a separate area from where 
the actual levels are. This way, players are separated and 
it feels like a single player game, but they can still talk 
and interact at the same time.



208  THE ULTIMATE ROBLOX BOOK: AN UNOFFICIAL GUIDE

�LIMITING PLAYER INTERFERENCE

�One of the biggest issues with online games is that you 
never know what kind of person you’re playing with. Most 
players will be fun, and they will play like they should. But 
sometimes other players think it’s funny to fool around 
when you’re playing. They might bother your character or 
make it difficult for you to progress through a game. 

Luckily, Roblox has a lot of features that make this less 
likely to happen, including great moderation of chat sys-
tems and the ability to report players. However, if you’re 
interested in making a game in Roblox, then you should be 
aware that some people online will try to make it harder for 
people to enjoy themselves. Here are a few things you can 
do to try and make it less likely for players to interfere with 
other players.

�MAKE PLAYERS START IN DIFFERENT SPOTS
One thing you can do, which I touched on briefly earlier 

in this chapter, is to actually separate players. When they 
load into your game world, you can have them spawn in 
a different area than the people who are actually playing 
the game. Doing this is easy. Remember the spawn marker 
we had back in the first Obby we made? Just place several 
of these in different areas so that each player spawns to a 
different spot in the game.
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�ROBUX
Most people online who want to bug other players are 

just doing it to be a pain. If you ask players to give you Ro-
bux for access to content in the game (like harder levels or 
certain items), then it’s less likely bullies or annoying play-
ers will bother to pay just to annoy other players. 

�MAKE THE GAME VERY COMPETITIVE
While this might sound like the opposite of what you 

want to do, it actually works. Instead of asking players to 
work together, which could result in some players doing 
the opposite just to annoy people, ask everyone to com-
pete and fight against each other. If everyone is trying to 
beat each other and that’s the objective, then other people 
getting in the way isn’t as much of a problem since that’s 
the whole point of your game.

�HOW TO KEEP PLAYERS COMING BACK

�Once you’ve figured out a formula that works for you, and 
you think your game is starting to be fun while you’re in the 
middle of developing it, then it’s time to think about the 
players. Making an amazing game is actually only a small 
part of the puzzle of releasing games on Roblox. Now you 
need to do the extra work to make sure it’s fun enough to 
keep people playing it and coming back more than once.
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�Building a Game with Friends
�you can also build those games in Roblox together with the 
help of your friends at the same time online. This feature is 
called Team Create. Click the View tab in Roblox Studio. Lo-
cate the Show section and invite friends to help you build 
your game using the Team Create feature. Each of you can 
add characters, quests, scripts, and so on. 

While the games we’ve made so far are good exercis-
es for new Roblox creators, they probably won’t attract a 
lot of random Roblox users. They’re too simple and basic. 
Here are some ideas for making your games more appeal-
ing to players so that they will want to keep playing.

�ADD RANDOM ELEMENTS
If your game is straightforward, in that you ask players 

to go from point A to point B at which time they “finish” ev-
erything, then they probably won’t ever play it again. If this 
straightforward game is really, really fun, then they might 
play one or two more times, but that’s it. 

That’s why adding in random elements is a great idea. 
Have enemies appear in different places, have random ef-
fects happen, give different rewards each time, etc. If things 
are unpredictable and different every time they play, then 
a player is more likely to come back for more.

For example, you could have players, or NPCs, randomly 
spawn on the map somewhere instead of at predetermined 
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spawn points. To do that, put this script by Roblox user 
Sporkyz in the object you want to have randomly spawn:

HHHTTT = Instance.new(“Model”, game.Workspace)
HHHTTT.Name = “SPLocate”

wait()
script.FirstSpawn:Destroy()

while wait() do
Instance.new(“SpawnLocation”, game.Workspace.SPLocate)
game.Workspace.SPLocate.SpawnLocation.Duration = 0
game.Workspace.SPLocate.SpawnLocation.Anchored = true
game.Workspace.SPLocate.SpawnLocation.CanCollide = false
game.Workspace.SPLocate.SpawnLocation.Transparency = 1
game.Workspace.SPLocate.SpawnLocation.CFrame =
CFrame.new(math.random(-349,486),0,math.random(-349,486))
wait(1)
game.Workspace.SPLocate.SpawnLocation:Destroy()
end

�HAVE PLAYERS WORK TOGETHER
Another great way to make your game more replayable 

is to ask players to  work together toward a common goal. 
Things are more exciting and different that way. Plus, the 
game is guaranteed to be different because a bunch of 
players won’t do the same thing every time. 
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RELEASE NEW LEVELS AND CONTENT
You can always just keep making new content and levels 

for your game. If you released an Obby with ten levels and 
the players loved it, then release a few more levels as an 
update to get people to come back to the game.

�BADGES AND DEVELOPER PRODUCTS
Players love collecting things and letting people know 

about their accomplishments. That’s why badges are so fun! 
You can create badges for your game as rewards for play-
ers who do specific things. To keep players coming back, 
you can make more badges, or make badges for beating 
levels with a certain score or within a certain timeframe. 

�TALK TO YOUR PLAYERS
If you’re really stuck for ideas on how to get players 

to come back, you could ask players for feedback. Start a 
forum post about your game and ask players for sugges-
tions on ways to improve it.

*  *  * 

�You should now consider yourself ready to make your 
game work for multiplayer. All of the best, most played, 
and most popular games on Roblox are all about players 
getting online and playing together.
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�You can never redo a first impression. The 
very first time a player touches your game 
will always and forever be the first time 

that player ever experienced it. No matter what 
you do they can’t take back the way they felt 
during those first few minutes. For simple Rob-
lox games that are usually totally free to play, the 
first few seconds are extremely important.
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�But also, what’s just as important as making a 
good first impression is knowing how to finish a 
game. Similarly, you cannot alter or change the 
way a player experiences the entire adventure 
and what they think at the end. A boring, bad, 
or totally predictable ending can ruin an other-
wise good game. You want to avoid this type of 
situation, and you can do this by knowing how to 
finish a game well. We’ll cover how to:

•	 �Further edit and customize models
•	 �Add custom audio
•	 �Change the sky
•	 �Add a scoreboard
•	 �Finalize the game for publishing
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�CONTINUE EDITING AND MAKING 
TWEAKS

�Making sure that your game stands out is very important, 
but don’t let that feeling that you need to change things 
just for the sake of changing them take over. If you have 
a strong idea of what your world should look like and the 
items from within the Toolbox are helping you achieve that 
vision then you should keep using them. 

At the same time, don’t feel constrained by what’s pro-
vided in the Toolbox. If you want a specific type or color 
of vehicle and can’t find what you’re looking for, then you 
should also know how to edit and create things on your 
own too.

When creating your first few games (like the ones de-
scribed in this book) there is no shame in not having a 
whole lot of customization. Your first games are going to 
feel less original, and that’s okay! You’re still learning! As 
long as you know what you need to improve at for future 
games then you’re doing well.

But the time will come when you want to customize 
your games. Beginning that process in Roblox is straight-
forward, and the first step is the easiest one: just editing 
what already exists in the Roblox Studio Toolbox. 
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�EDITING OBJECTS FROM THE TOOLBOX

�The best way to add some simple layers of customization to 
your game is to grab something that’s already been made in 
Roblox Studio and uploaded for others to use. You can do 
that in the Toolbox, just like we covered in Chapter 6 of this 
book. To give you some ideas, let’s try a few things. In the 
Toolbox search, type horse. The image shows you a horse I 
found. I went ahead and dropped it into the Castle template.

�Roblox Corporation

�A HORSE FROM THE TOOLBOX.

�The horse pictured in this image 
is relatively normal looking. It has a 
nice dark color with a saddle and ev-
erything else you’d expect to see on 
a horse. But what if you wanted this 
horse to be the leader of the pack? 
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Then it might look a little bit fancier than just your normal 
everyday horse, right? 

To add a bit of flair to the horse we can change a few 
colors. This will make it stand out a little more. Go ahead 
and alter the color of some parts of the saddle, give it 
some gold rings around the horseshoes, and make the bri-
dle around its face gold as well. Making those slight adjust-
ments already has the horse looking noticeably different 
than it did earlier. Then add a few more basic horses until 
you’ve created a group of them. When you’re finished, it 
will look like a bunch of horses are ready to be led on a 
journey! The image shows you how much nicer things can 
look with just a few quick edits.

�Roblox Corporation

�THREE HORSES WITH MINOR EDITS.

�The amount of editing you can do in Roblox Studio is 
extensive. Look at the Explorer panel (shown in the original 
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horse image, earlier). There, you can select individual pieces 
of objects and then edit them. You can even alter their script-
ing to adjust actions. Recall how we changed the time of day 
for the sky in the very first Obby game we made in Chapter 4, 
and how we made script alterations to a zombie in Chapter 9.

With a little bit of creativity, patience, and skill with 
computers, it’s not difficult to add extra layers of customi-
zation to your Roblox game. And if you want to make your 
very own models inside Roblox, you can do that. Check out 
Chapter 6 for details.

�UPLOADING CUSTOM AUDIO

�One of the best ways to customize your game is to up-
load custom audio that’s different from the stock audio 
that’s available in Roblox. Picking the right song or using 
the right sound effect could be the difference between a 
game being played once and a player coming back to it 
over and over again.

�UPLOADING YOUR OWN AUDIO FILES
It does cost Robux to upload a new sound file into the 

Roblox system. Any sound you upload will be reviewed to 
be sure it’s good for players of all ages. In addition to being 
checked to make sure it’s appropriate, an audio clip cannot 
be longer than seven minutes, and the file size cannot be 
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larger than 19.5 MB. The price will vary based on how long 
the file is, how large the file is, and what the sound is playing.

All you have to do to upload a sound is go to the main 
Roblox website and click the Develop tab at the top. On the 
page, locate the link that says Continue to Develop. After you 
agree to the terms, locate the Audio link from the list of op-
tions on the left side and then click it. (The Continue to Devel-
op page link might not appear for you on the Roblox website 
if you’ve been to the Develop page before. If so, you’ll au-
tomatically be directed to the Develop page as soon as you 
click on the Develop tab at the top of the Roblox website.)

Once you’ve clicked the Audio link and you’re on the 
Create an Audio page, you can upload an audio file like a 
song or sound effect, give it a name, and have the Roblox 
system tell you how many Robux it will cost to upload it 
into the system.

�USE AUDIO ALREADY IN ROBLOX
If you just want to use sound that’s already available in 

Roblox, you can do that using the Roblox Studio Toolbox, 
just like you would for models.

�CHANGING THE SKY IN A GAME

�The default sky in most Roblox games looks great. A beau-
tiful clear blue sky with a handful of clouds and a rising 
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sun is a classic look for most game projects. However, you 
might want to go for a slightly different feel. Earlier in this 
book we covered how to adjust the time of day on the de-
fault sky. In that example we made a bright blue sky look 
darker. But you might want to upload an entirely different 
sky altogether. Luckily, Roblox Studio lets you do that!

�UNDERSTANDING THE SKYBOX
First, you need to understand how the sky works in Ro-

blox. Like most game engines, Roblox actually uses what’s 
called a “skybox” because the sky is a collection of multi-
ple images that are connected together to form the illusion 
of a sky encircling the level. The images have to be set up 
just right for it to work, so they’re difficult to make from 
scratch. Think of how frustrating and annoying it is to put a 
sticker on something just right so it’s even and not wrinkled 
at all, or how hard it is to apply a screen protector to your 
phone. Imagine that times several giant images that are 
supposed to line up and look like a 3D sky. It’s not easy!

�GETTING A NEW SKYBOX
You can find a lot of great skyboxes online through Goo-

gle, on Roblox forums, and in official Roblox blog posts 
too. You can also find some in the Toolbox on Roblox Stu-
dio as well. Just type skybox in the search bar to find a new 
one. When you click it, the program will automatically put it 
in your game world and give you a nice new sky.
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�ADDING A SCOREBOARD

�One of the most important finishing touches that you can put 
on any game is a scoreboard. When multiple players compete 
against each other, they need to see how many points they 
have and who is winning. That’s what scoreboards are for!

To create a scoreboard in Roblox, you’ll need to do a bit 
of scripting. There are dozens of scripts available for down-
load in the Models section of either the Roblox website or 
in the Toolbox on Roblox Studio. For this example, we’ll 
be using the official “Leaderboard” script that’s created 
and uploaded by Roblox. You can find its page at this link: 
www.roblox.com/library/53310/Leaderboard.

When used, this script creates a scoreboard in the top 
right corner of the screen while playing your game that 
shows a list of players with a number designating how 
many “kills” each player has gotten (known as KOs, which 
is short for knockouts) and how many times they’ve each 
died (known as wipeouts).

There are two ways you can access and use this script:

1.	 From the Roblox library page link, click the Get  
button to have it added to your inventory of mod-
els. When you’re in Roblox Studio, use the Toolbox 
drop-down menu and select My Models to bring up 
a list of all models you’ve made or claimed. “Leader-
board” by Roblox should appear there.
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2.	 The other way to is to navigate to the Toolbox inside 
Roblox Studio and just type “Leaderboard” into the 
search field. You’ll find dozens of results, but one of 
them will be the correct Leaderboard script. Hover 
over each of them until you find the official one cre-
ated by the “Roblox” username.

Once you locate it, all you have to do is click on it in the 
Toolbox and it will automatically be added to your game. In 
the Explorer on the right side of Roblox Studio, it will show 
up as “LinkedLeaderboard” by default. (The actual text of 
the script is too long to include in the book.)

�Roblox Corporation

�HERE’S WHAT YOUR SCOREBOARD COULD LOOK LIKE.

�That’s all you have to do with this script; no customization 
is necessary. It will automatically track kills and deaths for you 
to complete any simple multiplayer competitive action game 
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as shown in the screenshot. Adding in the rest is totally up to 
you and how you want to design your game.

�FINALIZING THE GAME FOR PUBLISHING

�Once you’ve finished working on your game (whether it 
be an Obby, a racing game, an action game, an adventure 
game, or something else) and you have it in a state that you 
think is ready for strangers online to start seeing, then it’s 
time to publish it to Roblox! 

Taking that final step is super simple and is very similar 
to publishing a model on Roblox. Here’s what you do:

1.	 Triple-check everything in your game and make sure 
it works just like you want it to.

2.	 Click the File button in the top left corner of Roblox 
Studio and click Save As… and save a copy of the 
project on your computer as a backup.

3.	 Click the File button in the top left corner of Roblox 
Studio again and then click the Publish to Roblox 
as… option.

4.	 Click the Create New option to make a brand-new 
place for your game to exist in.
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�Roblox Corporation

�FILL OUT DETAILS ABOUT YOUR GAME IN THIS WINDOW.

5.	 Now you should see the window shown in the image. 
Input the basic information about your game such as 
the name, description, and select a game genre in the 
drop-down menu. You can get some ideas in the ex-
ample or by seeing what other users put on their game 
pages in Roblox.

6.	 Click Thumbnails on the left side and upload images 
of your game.

7.	 Click Access on the left side and pick which types of 
players can play your game. You can limit it to just 
Computer, Phone, Tablet, or Console, or any combi-
nation of the four, or all four. There are also options 
to limit the maximum number of players, and indi-
cate the preferred number of players. You can even 
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limit your game to only Builders Club members and 
enable VIP Servers that players can spend Robux on 
for private games.

8.	 Click Advanced Settings on the left side and choose 
which genres the game is associated with, either 
just the one you picked, or all of them. You can also 
choose which types of gear players can use in your 
game and how other permissions (like chat restric-
tions) work. 

Once you’re done picking all of the settings, click the 
green Create Place button at the bottom of this box and 
your game will be uploaded for everyone to try on Roblox!

*  *  * 

�That covers some of the ways you can customize and 
finish your game in Roblox so that you can make it feel 
like it’s even more of your own. There are plenty of other 
ways to customize your games once you dig deeper into 
the features that Roblox Studio has available.

We’ve got one chapter left in this book. In that last 
chapter, we’ll explore some ways you can make actual real 
money in Roblox. And then you’ll be done with the entire 
book (all that’s left is a Q&A for your parents and the Ad-
ditional Resources section)!
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Making Money 
with Roblox

�Chapter

14
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�This final chapter focuses on making real 
money in Roblox. Everyone knows that you 
can play thousands of games for free with 

Roblox and that you can make your own games to 
share with people online. But did you know that 
you can actually make money in the real world 
doing all of that too?



229

�Well, you can! There are actually several ways 
to make money in Roblox, and many of them are 
pretty easy. Of course, this doesn’t mean that 
you can become a millionaire and quit school or 
never go to a regular job, but if it’s okay with 
your parents, you can make a little bit of money 
just from doing fun stuff inside Roblox itself. In 
this book’s final chapter I will cover:

•	 �Robux exchanging
•	 �Making money from created games
•	 �Trading items
•	 �Using promotional links
•	 �Avoiding scam sites and games
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�HOW ROBUX WORKS

�Since Roblox is a game that operates entirely off of digi-
tal currency Robux, earning money through the game is a 
little more complicated than just selling things directly to 
other users. When a user pays money to the creators of 
Roblox, they receive the digital Robux currency in return. 
Users can then spend Robux on things within Roblox. If a 
particular user created the thing that’s being purchased 
(versus an item made by the creators of Roblox), then they 
receive part of the Robux amount for that purchase. 

Once a user has enough Robux saved up, they can trade 
those in for actual money using the Developer Exchange 
program. In other words, users don’t actually get paid di-
rectly in cash, but the Robux they get can be turned in for 
actual money. It’s sort of like when you trade in your tickets 
at Chuck E. Cheese’s or another similar arcade, except in-
stead of getting prizes you get money.

There are lots of different ways that you could poten-
tially make money in Roblox, so we’ll spend the rest of this 
chapter talking about each of the different ways.

�MAKING MONEY ON ROBLOX ISN’T EASY

�Actually getting to the point where you’re able to make money 
from Roblox is very hard, though. Just because you know how 
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to make a few simple games like the ones described in this 
book doesn’t mean you’ll be able to make money in Roblox. 

Even if you have a great idea for a game, know how to 
make it, go out and create it, and get people playing it, 
that doesn’t mean you’ll make any money. If you’re inter-
ested in playing Roblox and making games in Roblox, just 
make sure it’s for the right reasons. Unfortunately, trying to 
get rich quick is not one of those reasons.

That being said, it is possible to make some money 
from Roblox. Now let’s get into it!

�MAKING MONEY FROM CREATED GAMES

�Most people spend the vast majority of their time in Rob-
lox actually playing games. There is a lot of other stuff you 
can do—from talking to friends, messaging people, trad-
ing items, customizing your avatar, and of course making 
things in Roblox Studio—but the biggest source of fun for 
the millions of players is just simply playing Roblox games.

The best way to make money from making games in 
Roblox is to find a combination of these actions: asking 
players to buy access, selling Game Passes, and charging 
for Developer Products. Using only one of those strategies 
won’t be as effective as trying to use all three or some oth-
er combination that makes sense for what you’re making. 
Just make sure that what you try to charge seems fair. 
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�CHARGING ROBUX FOR ACCESS
The most common and well-known way to make money 

in Roblox is to earn it directly from people wanting to play 
the games that you’ve created. If you go on the Roblox 
website looking for a game to play, you will probably no-
tice that most of the games are completely free. All you 
have to do to play these games is press the giant Play but-
ton that appears right on the page.

�Roblox User: Den_S

�THE SCREEN WHERE YOU CAN PLAY THEME PARK TYCOON 2.

�As the image demonstrates, this game, Theme Park Tycoon 
2, is free to play. All you have to do is hit Play and you’re in! In 
most cases, if you release a game for Roblox, it will be totally 
free for people to play however and whenever they want.

However, it is possible to make games that people have 
to pay in order to play at all. Instead of having a Play but-
ton these games will have a Buy Access button with the 
amount of Robux listed. 
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�Roblox User: Coeptus

�THE SCREEN WHERE YOU CAN PLAY WELCOME TO BLOXBURG.

�In this example for Welcome to Bloxburg, you can see that 
in order to play this game you need to have 25 Robux in your 
account. When you click that button, it will subtract those Ro-
bux from your account. Once you buy access to a game once, 
it’s always open to you and you don’t have to buy access 
again. Just like when you buy an app or game on your phone 
or other game system, you can play it whenever you want.

This is one of the most common ways that users will 
try to make money from Roblox, but it isn’t necessarily the 
best way. Once a user buys access, they won’t spend mon-
ey on your game again so you won’t be able to make as 
much money over a long period of time. 

�GAME PASSES
Another popular way of making money from games that 

you’ve made in Roblox Studio is through Game Passes. In 
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other games on smartphones, the computer, or a game 
system like the PlayStation 4 or Xbox One, you may have 
heard of something called DLC, which means “download-
able content.” Game Passes are a lot like DLC.

How do these work? After a player has bought access to 
your game (or is simply playing it for free), they can choose 
to go to the Store section of your game page and give you 
money in a one-time exchange for Game Passes. These 
Game Passes come in all sorts of types and offer all sorts of 
rewards that you can’t get in the game itself. For example, 
there are optional Game Passes for Welcome to Bloxburg.

�Roblox User: Coeptus

�GAME PASSES IN THE STORE FOR WELCOME TO BLOXBURG.

�The Game Passes shown for this game are Unlocked 
Stereo, Excellent Employee, Premium, Multiple Floors, and 
Advanced Placing. When you click one of the Game Pass-
es, such as Premium, you’re taken to a new screen with 
more information about that Game Pass.
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�Roblox User: Coeptus

THE PREMIUM GAME PASS IN WELCOME TO BLOXBURG.

�This Game Pass, when purchased, gives you a bunch 
of different bonuses when playing Welcome to Bloxburg. 
After you buy it, you get: 

•	 �Twice as many daily rewards in the game
•	 �A special name tag
•	 �The ability to choose your plot in the game
•	 �Even more upcoming rewards that will be specially 

made for Premium players

As you can tell, the creator of the game made this Game 
Pass for people who like to play the game a lot, possibly 
even every day. Those are the types of players that will get 
the most benefit from buying this Game Pass.

The other Game Passes in Welcome to Bloxburg offer 
very different bonuses: 
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•	 �The Unlocked Stereo Game Pass lets you play any 
Roblox Sound ID music track in the game and opens 
up more areas to play music.

•	 �The Advanced Placing Game Pass lets you place ob-
jects in more areas when building things in the game. 

Some users even make Game Passes that are just called 
Tip Jar, or something similar, and ask players to donate 
money to thank them for their hard work.

When you create a Game Pass for your game, it’s im-
portant that you understand the type of player you’re mak-
ing the Game Pass for, meaning that you should know what 
they’d be interested in. For example, if you made an Obby 
game, then it might make sense to sell Game Passes for 
unlimited lives so players don’t have to start over after run-
ning out of lives. But in that Obby it might not make sense 
to offer something like the Unlocked Stereo Game Pass.

�DEVELOPER PRODUCTS
Game Passes can only be purchased one time each by play-

ers, but Developer Products can be purchased over and over 
again by those same players. There are a lot of different ways 
that you can implement Developer Products into your game. 

�Convenience Purchases
Game developers might decide to use Developer Prod-

ucts to let players purchase in-game currency, for example. 
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Imagine if you were playing a roleplaying game as a warrior 
in Roblox and didn’t have enough gold in the game to buy a 
new sword in town. The developer of the game may decide 
to let you just get more gold by paying some Robux instead 
of having to slowly earn it in the game itself. These are com-
monly referred to as convenience purchases in other games 
since they make the game a little easier and less frustrating.

�Roblox Corporation

�AN EXAMPLE OF IN-GAME PURCHASES.

�In this image, you can see an example of how Devel-
oper Products can be used to let players purchase items 
within the game itself using in-game currency. 

�ADDITIONAL PLAYS
There are lots of other uses for Developer Products 

too, though. Some games on Roblox are free to play a few 
times, for example, but if you want to play them more than 
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the limited number, then you may need to purchase addi-
tional plays as a Developer Product. It works sort of like 
tokens at Chuck E. Cheese’s or an arcade. 

�BUYING AND TRADING LIMITED ITEMS

�While playing Roblox, you will probably come across Limit-
ed items. These are items that the creators of Roblox once 
sold to users but no longer sell. It’s like a Lego set that was 
discontinued or a trading card that’s no longer printed. As 
a player, if you buy one of these items, you can be the 
proud owner of something that is extremely rare. Howev-
er, since people love to collect rare items that are related 
to things they love (like Roblox) you can probably imagine 
how frustrating it would be if you missed out on buying a 
really cool Limited item.

People miss out on buying a Limited item all the time. 
The creators of Roblox do this on purpose because they 
want certain items to be special. A good example is if they 
decide to release a brand-new hat as part of a special pro-
motion one week and are only selling 1,000 hats. Well, mil-
lions of people play Roblox every month, so tons of users 
won’t get that hat. 

That’s where selling and trading comes into play in Ro-
blox. If you buy a Limited item when it is available directly 
from the makers of Roblox, then hold on to it and wait for 
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a few months until it’s no longer available, then you can 
probably find someone who will be willing to buy it for 
much more than you paid for it. 

There are a couple of risks with this strategy, though: 

•	 �There is no guarantee that the Limited item you 
bought will be worth more in the future, although 
that is what usually happens. 

•	 �Sometimes it can be hard to find someone who 
wants to buy or trade the item that you’re looking 
to get rid of. 

Joining trade groups on Roblox is a good way to track 
down interested buyers.

�AVOIDING ROBUX SCAMS

�Now that we’ve covered a few of the ways that you can 
make money in Roblox, you should learn about some of the 
ways that you absolutely cannot make money in Roblox. 
Some people on the Internet will try to trick you and lie to 
you, so it’s important to always be safe and aware when 
talking to someone online who you don’t know or when 
you’re playing a multiplayer game like Roblox. From now 
on I will call these situations where someone tries to trick 
you with Robux money as a “scam.”
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One of the most common scams you’ll see in Roblox is 
just in the comment section of games, forum posts, and 
messages from players. A lot of users create accounts and 
then post messages about being able to get “free Robux” 
for players, but that’s never true. Sometimes they ask for 
your username and password or tell you to click a link to a 
website where you can get free Robux, but you should nev-
er trust any of it. The only way to get Robux in Roblox is to 
pay for it or by being part of the Builders Club. If someone 
tells you to click something or to sign up for something to 
get free Robux, then it’s a scam.

Also, in the Games section of the Roblox website, you 
might come across games that say you can get Robux by 
playing them, if you input your account name and pass-
word. This is a scam. In fact, never, ever give away your 
password to anyone. Again, this is 100 percent a scam, and 
you cannot get Robux this way.

For more information about staying safe online and 
protecting your account, talk to your parents.

*  *  * 

�That’s it! You’ve reached the end of the entire book! 
Congratulations. Go out there and make some great 
games!
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Q&A FOR PARENTS

�This section contains common questions that parents and 
caregivers might ask about Roblox.

�HOW DOES ROBLOX WORK?

�This is how Roblox operates:

•	 �A new user creates a username when they make their 
account, which is represented by a digital avatar in 
the game world.

•	 �Users talk to each other using in-game chat, private 
messaging, and online forums. Users can also re-
strict who is able to communicate with them.

•	 �Every user is granted “game” space, like virtual real 
estate, to build things and create experiences.

•	 �When playing games made by other people, users are 
identified only by their username and virtual avatar.

•	 �Users can use real money to purchase Robux (often 
denoted as R$ in the game), a digital currency inside 
the game world, which lets users buy premium con-
tent, special items, and other in-game rewards.

•	 �Users over thirteen years old can sell items in return 
for Robux. Robux can then be exchanged for real 
money using the Developer Exchange program.
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When a user makes an account, that user will need to pro-
vide certain information such as name, age, and email ad-
dress, but Roblox will not display or provide that information 
to other users. It’s purely used for Roblox to ensure your ex-
perience is appropriate. All users under the age of thirteen 
will need assistance from a parent to create a full account.

�WHAT IS ROBLOX’S PRIVACY POLICY?

�The Roblox privacy policy was created to account for con-
cerns with users’ personal information, how it is accessed, 
and how it is shared. The policy is updated all the time 
to account for new changes and features. Visit it here: 
www.roblox.com/info/privacy.

�WHAT INFORMATION WILL ROBLOX 
COLLECT FROM A USER?

�Roblox does collect some information from users while play-
ing. Technologies like tracking cookies, beacons, scripts, 
and tags are purely used to keep tabs on user preferences 
and tendencies. If the game has bugs or crashes, reports 
are sent to Roblox so they can analyze what happened and 
try to fix issues. This is common practice for any website 
or online game. It’s the same reason websites like Amazon 
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email you about stuff you’ve looked at in the past or you 
see advertisements on Facebook and YouTube for things 
you’ve recently looked up online.

�WHAT TYPES OF PARENTAL CONTROLS 
ARE AVAILABLE ON THE SITE?

�Children under the age of thirteen are required to use a 
parent’s email address to create an account. When doing 
so you will receive an email notification with a link to adjust 
the account’s settings. 

If your child is under the age of thirteen, they can only 
interact with Roblox in what is known as Privacy Mode. This 
system will filter out certain language and restrict other 
users from directly interacting with users when they’re not 
in a game. Chat functions and message boards are also 
moderated to make sure children do not share any of their 
private information. All text is filtered for profanity, adult 
language, and suggestive content at all times with a com-
bination of human and automatic systems.

In the Privacy tab of the Account Settings section you 
can adjust who is able to make contact with your child in the 
game and who can send direct invitations. The first field is 
called Contact Settings and is automatically set to Default. 
The default settings restrict messages and app chatting to 
friends only, but when inside of a game any of the other 
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players can talk to your child. This is where you can adjust 
who can send the user messages, who can chat with the user 
in the app itself, and who can chat with the user in games. 
Make adjustments if you don’t like the default settings. 

The Other Settings field determines who can send invi-
tations for VIP Servers and who can join your games. Most 
of the settings such as “Who can message me?” and “Who 
can chat with me in game?” are defaulted to restrict access 
to friends only, but can also be turned off or opened up 
entirely, as you choose what’s most appropriate.

If you have a question, would like to ask for a change, or 
want more information about anything in Roblox, then you 
can get in touch with the creators of the game by emailing 
info@roblox.com.

�DOES ROBLOX HAVE ANY CONNEC-
TION TO SOCIAL MEDIA?

�It can—but it doesn’t have to. In the Social Networks sec-
tion (which appears under the Account Info section) you 
can add links to Facebook, Twitter, Google+, YouTube, and 
Twitch accounts. There is also an option to adjust the set-
tings so these links are visible to either no one, friends, us-
ers you follow, your followers, or everyone. If you decide to 
link these accounts, then you can have things like badges 
automatically post on your news feeds, log in to your Ro-
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blox account through Facebook, and display links to your 
different profiles and channels for friends and followers.

�COULD MY CHILD ACCIDENTALLY 
SEE INAPPROPRIATE CONTENT?

�The privacy features in Roblox do a good job of filtering out 
inappropriate content, but it’s far from perfect. Sometimes 
users create games that appear to be innocent, but they 
find inappropriate content that the filters and moderators 
do not catch. This content could include suggestive ma-
terial, profanity, overt violence, and other mature themes. 

Typically, inappropriate content is reported, removed, or 
hidden quickly, but there is still a chance that a child could 
see, read, or hear something inappropriate. 

�WHAT DOES ROBLOX DO TO TRY TO 
ENSURE SAFETY FOR UNDERAGE USERS?

�Roblox has received a kidSAFE-CERTIFIED Seal for its 
website, user experience, and game programs. What this 
means is that the independent safety certification service, 
kidSAFE, has awarded the program a seal of approval sig-
nifying that it complies with established online safety and 
privacy standards. 
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Additionally, Roblox has earned the second-level kid-
SAFE + COPPA-CERTIFIED Seal. This means that the pro-
gram complies with the Children’s Online Privacy Pro-
tection Act (COPPA), which has been in effect since the 
year 2000. For more information about the kidSAFE Seal 
Program and its seals, you can visit the website here: 
www.kidsafeseal.com/aboutourseals.html.

�CAN MY CHILD CHAT WITH OTHER 
PLAYERS?

�Yes, there are chat boxes in every game so users can talk to 
other players playing the same game. In the Privacy tab of 
the Account Settings section you can adjust who is able to 
make contact with your child. The first field is called Con-
tact Settings. This is where you can adjust who can send 
the user messages, who can chat with the user in the app 
itself, and who can chat with the user in games.

�DO THE CHAT WINDOWS HAVE FILTERS 
FOR INAPPROPRIATE LANGUAGE?

�Yes. But even if your account is for ages below thirteen, there is 
a chance that some profanity and vulgar language can still slip 
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through chat filters. This is due to the fact that a lot of users get 
intentionally creative about how they type their messages and 
replace letters with symbols or numbers so the filtering system 
doesn’t immediately pick up on the profane language. 

Playing games online with strangers always has a cer-
tain degree of risk in this way and there’s not much else 
that can be done about it that isn’t being done already. 

�HOW MUCH DOES ROBLOX COST?

�There are four types of Roblox membership. If you just made 
an account, then you’re in the Free tier. As a free member, 
you can play games and publish your own basic games, but 
you’re limited in the more advanced features of the game. 
You don’t get a daily allowance of Robux for purchasing pre-
mium items, you will see ads in the games and website, you 
can’t create groups, you can’t sell stuff, and you don’t get 
any bonus gear, among plenty of other things.

The Builders Club features three types of paid member-
ship. They are Classic, Turbo, and Outrageous. The bene-
fits scale with the cost. Whether or not the different types 
of membership are worth the monthly cost is entirely sub-
jective and depends on not only how often your child plays 
Roblox, but what he or she does while playing. 

If your child simply wants to log on to play free games 
every now and then, it probably isn’t worth it to join the 
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Builders Club. But if you want your child to try and sell 
some of his or her items and content in games or want to 
get more involved with the community, then you may want 
to sign up for one of the paid tiers.

�HOW CAN ROBLOX USE COPYRIGHTED 
CHARACTERS AND BRANDS?

�Roblox is a funny little platform. Since Roblox itself is a 
game technically that you can access for free and only acts 
as a host to other users’ creations, most of which are also 
free to access for the most part, the issue of copyright 
ownership isn’t usually important. However, things can get 
a little fuzzy when people clearly create entire games, such 
as Pokémon Brick Bronze, that directly reference and use 
copyrighted materials.

Officially, according to the official Roblox FAQ and 
Terms of Use materials, users are only able to work with 
copyrighted content (such as Pokémon) if they have writ-
ten permission from the creators. In most cases, Roblox 
users do not have written permission. That being said, The 
Pokémon Company likely doesn’t think it’s a valuable use 
of time to target a small fan project like Pokémon Brick 
Bronze since the users are only profiting off of the sale of 
in-game purchases and not the sale or ownership of the 
material itself.
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�HOW DOES ROBUX “MONEY” WORK?

�Users can purchase Robux (a digital currency used only on 
the Roblox website) using a credit card. Robux can typically 
be purchased as either a one-time transaction or by subscrib-
ing with a monthly fee and getting a daily allowance of Robux 
as a perk of subscribing. They can use these Robux to buy: 

•	 �Access into certain games
•	 �Items for their game characters to wear
•	 �Special features or levels in games

�HOW CAN MY CHILD MAKE MONEY 
OFF ROBLOX?

�If your child creates a game or level that requires users 
to pay Robux to access, or an item that requires Robux 
to purchase, he/she gets part of that money into his/her 
Robux account every time someone buys that access or 
item. Those Robux can be converted back into real money 
through the Developer Exchange program. This process is 
called “cashing out.” In order to cash out, a user needs at 
least 100,000 Robux and must be a member of the Outra-
geous tier in the Roblox Builders Club subscription service. 
The exchange rate per Robux unit will fluctuate over time, 
just like the value of actual money.
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�ARE THERE ANY SCAMS INSIDE 
ROBLOX?

�Unfortunately, yes. Sometimes a player will be offering free 
Robux. A lot of users create accounts and then post mes-
sages about being able to get “free Robux” for players, 
but that’s never true. Some games will even have a little 
box that pops up while you’re playing saying you will get 
free Robux if you input your account name and password. 
That’s also a scam. The website monitors closely for these 
types of scams and shuts them down as quickly as possi-
ble, but as with other scams like this on the Internet, they 
do pop up every once in a while. 
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ADDITIONAL RESOURCES

�Roblox is a very complex and massive game. You cannot 
possibly learn everything there is to know about Roblox 
just by reading this one book. In fact, since Roblox is an on-
line platform that lets players make their own games, that 
means it is always being updated and changed. Simply, it’s 
impossible to know everything about it. As a result, I’ve 
put together a list of additional resources that you can turn 
to if you want to keep learning more about Roblox and all 
of the things that you can do with Roblox Studio.

Some of them are official resources, which means they 
come directly from Roblox Corporation, the company that 
actually makes Roblox itself. The other resources are unof-
ficial (like this book), which means they come from people 
not directly associated with Roblox Corporation.

�OFFICIAL RESOURCES
This is a list of official resources you can turn to for more 

help and information about playing and building in Roblox. 
All of these resources come directly from Roblox Corpora-
tion, the creators of the game.

�The Roblox Blog
At the Roblox website you can find the Roblox Blog. 

Every few days, a new post is put up on the Roblox Blog 
so it’s a good idea to check it frequently. This is where the 
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developers who make Roblox will post news announce-
ments, contests, new features, and in-game tournaments. 
Even if you’ve been playing Roblox for years, you should 
check the blog every now and then just to see if there is 
anything new that you may have missed. You can find the 
blog at https://blog.roblox.com.

�Social Media Accounts
The creators of Roblox also have social media accounts 

that they keep updated on sites like Twitter, Facebook, and 
Instagram. These are all official accounts with hundreds of 
thousands of followers. The Twitter and Facebook accounts 
are mostly used to post links to the previously mentioned 
blog articles, and the Instagram account posts images and 
screenshots from within many of the most popular game 
worlds on Roblox. Children should ask their parents if it’s 
okay for them to look at these accounts.

�Roblox YouTube Channel
After you finish this book, we highly recommend that 

you visit the official Roblox YouTube channel. It’s packed 
full of useful videos that show a lot of the game’s best fea-
tures. One of my favorite parts of the channel is the Roblox 
University playlist, which is packed full of useful tutorials on 
how to make specific types of games. Children should ask 
their parents if it’s okay to watch these videos.
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�Roblox Wiki
The Roblox Wiki is one of the most comprehensive 

sources of official information about Roblox that you can 
find online. Everything from what the game is, how to build 
things, how to script actions, and so much more is elabo-
rated on within the pages of the Roblox Wiki. Once you 
finish this book, it’s a great idea to check the Roblox Wiki 
next to continue learning: http://wiki.roblox.com. 

This is a list of other places you can turn to get infor-
mation on Roblox. Since the game is so complex and is 
always changing, a lot of the community’s smartest and 
most passionate users have taken it upon themselves to 
create instructional videos, tutorials, and more on how to 
do things in Roblox and Roblox Studio. Just keep in mind 
that I (and likely the Roblox Corporation) do not necessar-
ily approve of any other unofficial sources that you might 
find online.

�YouTube Tutorials
If you go on YouTube and search for something related 

to Roblox, then you will probably get thousands of results. 
Since millions of people play the game every month, a lot 
of people probably make YouTube videos about it too. So if 
you want more details on how to do scripting in Roblox, or 
how to make a specific type of game, you could search for 
that. Just keep in mind that the stuff you find on there isn’t 
part of Roblox Corporation unless it comes directly from the 
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official Roblox account. Children should be sure to check 
with their parents before they search for things on YouTube.

�Roblox User Forums
The Roblox Forum is officially hosted by Roblox Corpo-

ration, but that doesn’t mean everything you see on there 
is from them directly. Some users are labeled as Modera-
tors, which means Roblox Corporation has selected them 
as official voices in the community, but even then they’re 
not actual developers of the game. 

There are thousands of conversations happening on the 
Roblox Forum all the time, but not all of them are going to 
have accurate information. That being said, there are lots 
of very helpful tutorials, guides, and other resources on 
there! You can join the conversation at the Roblox Forum: 
https://forum.roblox.com/.

�Other Books
While I did a whole bunch of research to write this book 

and included a ton of information, I’m not actually part of 
Roblox Corporation. Read other books for more informa-
tion from someone else’s perspective. 

�Other Internet Resources
There is still more that you can find on Roblox just by 

searching on Google. Children should be sure to check 
with their parents before searching the Internet.
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